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RESUMEN 

Los fármacos como una herramienta principal en la salud necesitan ser analizados 

para comprobar su efecto terapéutico. Las células y los órganos diana donde el 

fármaco realiza su función, necesita estudiarse con la mayor precisión posible para 

así evitar efectos adversos o no deseados en otras células u órganos. El surgimiento 

de software que permita realizar prácticas y análisis de las interacciones entre 

células, órganos y demás con fármacos, permite varias ventajas, desde disminuir o 

erradicar el uso de animales de laboratorio, costos, alimentación, cuidados, tiempo 

y demás beneficios. 

En el presente trabajo, se realiza un manual que aborda ejercicios virtuales de 

farmacología que faciliten el análisis y la comprensión de cómo actúan los fármacos 

sobre sus dianas terapéuticas, llevando a cabo una revisión y análisis de artículos en 

plataformas como Web of Science, PubMed, SciFinder, Google Academic, etc., e 

igualmente la investigación de las características, instalación y manejo de programas 

sobre docking molecular y simuladores virtuales para elaborar ejercicios con 

simuladores farmacológicos de acceso libre para estudiar y comprender el efecto que 

tiene el fármaco sobre el organismo. 

El presente trabajo se divide en dos capítulos, en el primero, se elaboran ejercicios 

virtuales y una guía para la instalación y manejo del programa OBSim: Organ Bath 

Simulation (Strathclyde Pharmacology Simulations), el cual simula experimentos 

farmacológicos en tejidos aislados o animales completos, aplicando una variedad de 

medicamentos en concentraciones variables para lograr observar sus efectos 

farmacológicos. En el segundo, se elaboran ejercicios virtuales y guías para la 

instalación y manejo de diversos programas, los cuales se complementan para 

realizar acoplamiento molecular, prediciendo la interacción entre un fármaco y una 

proteína a nivel molecular. 

INTRODUCCIÓN 

El uso de animales de laboratorio ha sido una parte central de la investigación para 

el descubrimiento de nuevos fármacos. Por consecuencia, es necesaria la educación 

y formación que permita a los estudiantes de la Licenciatura en Química 

Farmacéutica Biológica, obtener habilidades y conocimiento acerca del cuidado y 

manejo de los animales, así como el diseño experimental y el análisis estadístico que 

se lleva a cabo (Badyal & Desai, 2014; Elhajji & Basheti, 2018). 

Sin embargo, el uso de animales para experimentación ha llevado a muchos debates, 

entre ellos el tiempo y dinero elevados como el sacrificio de muchos ejemplares. 
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Partiendo de ello, es fundamental la búsqueda de nuevas alternativas que cumplan 

con los objetivos y puedan demostrar in vitro los resultados que se puedan observar 

in vivo (Singh et al., 2016; Sivakrishnan & Anbiah, 2021). 

La pandemia de COVID-19 trajo consigo desventajas como la interrupción de la 

enseñanza en aulas presenciales. Los retos que conllevaban mover sistemas 

educativos del modo presencial al electrónico se hicieron mayormente presentes 

cuando se habló de las prácticas que ya se tenían en cuenta de forma presencial 

(Ezeala et al., 2021). En muchas universidades a nivel mundial, entre ellas la 

Universidad Autónoma Metropolitana (UAM), optaron por programas 

computacionales que simularan experimentos farmacológicos. 

El objetivo de los simuladores farmacológicos es poder transmitir el conocimiento 

de la aplicación farmacológica como los conceptos básicos y clínicos a los 

estudiantes; siendo la simulación una técnica educacional que asemeja experiencias 

reales que replican aspectos de la práctica de manera interactiva (Andrews & Barta, 

2020). 

Capítulo 1. SIMULADOR DE ÓRGANO AISLADO OBSim 

1.1 EL PROGRAMA OBSim: Organ Bath Simulation 

Los experimentos farmacológicos in vitro de órgano aislado proveen información 

relevante para el descubrimiento o cuantificación del efecto de los fármacos en 

tejidos específicos antes de su aplicación en humanos o animales vivos. Las 

propiedades farmacológicas de la mayoría de los fármacos actuales fueron 

elucidadas con este método y continúan siendo parte esencial en el proceso del 

descubrimiento de nuevos y mejores fármacos. 

El programa OBSim: Organ Bath Simulation simula experimentos farmacológicos in 

vitro usando cuatro diferentes tipos de tejidos: íleon de cobayo, yeyuno de conejo, 

arteria de rata y biventer de pollo. 

1.2 AGONISTAS Y ANTAGONISTAS 

Para que los fármacos puedan ejercer su efecto, estos deben interactuar 

químicamente con los receptores celulares de acuerdo con su tamaño, carga 

eléctrica, forma y composición adecuada, provocando un cambio conformacional a 

nivel de la estructura molecular. Algunos receptores provocan la apertura de un 

canal iónico o una estimulación enzimática cuando un fármaco logra hacer contacto 

con ellos. Por lo tanto, un agonista farmacológico puede ejercer efectos similares a 

los agonistas endógenos como las hormonas y los neurotransmisores. Muchos de 
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ellos pueden provocar una respuesta máxima en el organismo, la cual es buscada 

por los fármacos para ejercer el mismo efecto. Los agonistas parciales provocan una 

respuesta media y pueden prevenir la unión de mediadores, disminuyendo la 

respuesta en el organismo (Bond & Ijzerman, 2006; Daeffler & Landry, 2000; Landry 

& Gies, 2008). 

Los fármacos antagonistas ejercen el efecto contrario a los agonistas, estos buscan 

inutilizar los receptores a los que se unen o, en todo caso, impedir que un agonista, 

endógeno o farmacológico, ejerza su efecto. Estos pueden ser competitivos, 

compitiendo con otras moléculas, y evitan su unión a los receptores estabilizando al 

receptor en su estado inactivo, pero su efecto puede superarse, en algunos casos si 

la unión del antagonista no es covalente, aumentando la dosis del agonista. Aquellos 

antagonistas cuya unión es muy fuerte al receptor o covalente, se conocen como 

antagonistas irreversibles o pseudoirreversibles. También, están los antagonistas 

que no se unen al mismo sitio de unión que un agonista, se unen a un sitio diferente 

y actúan alostéricamente potenciando o inhibiendo la acción del agonista (Bond & 

Ijzerman, 2006; Daeffler & Landry, 2000; Landry & Gies, 2008).  

Las respuestas a los medicamentos por lo general aumentan cuando incrementa la 

dosis. Sin embargo, llega un momento en el cual la respuesta llega a un límite no 

importando el aumento de dosis, la respuesta no aumentará haciendo una curva 

hiperbólica como consecuencia de acuerdo con la siguiente ecuación: 

𝐸 =
𝐸𝑚á𝑥 × 𝐶

𝐶 + 𝐸𝐶50
 

Donde E es el efecto observado en la concentración C. Emáx es la respuesta máxima 

que produjo o puede ser producida por el fármaco. EC50 es el 50% de efecto máximo 

de la concentración del fármaco (Christopoulos, 2014; Kenakin & Christopoulos, 

2013; Kenakin et al., 2012; Shonberg et al., 2014). 

En el equilibrio, la proporción de receptores ocupados por un agonista (A) 

disminuye en presencia de un antagonista (B). La unión del antagonista a los 

receptores impide la unión del agonista, pero la relación entre la ocupación y la 

respuesta del agonista no varía, por lo que el cociente entre las concentraciones de 

agonista cuando no hay antagonista presente [A] y cuando se encuentra un 

antagonista presente [A’] se conoce como la razón de dosis (Aronson, 2007; 

Arunlakshana & Schild, 1959; Gaddum, 1937; Tallarida et al., 1979). 
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La escala pA como una medida empírica del antagonismo farmacológico, se define 

como “el logaritmo negativo en base 10 de la concentración molar de un fármaco 

antagonista capaz de reducir el efecto de una dosis múltiple (x) de un fármaco 

agonista a aquel que produce una dosis única” (Schild, 1947). 

El pA2 puede definirse como el logaritmo inverso de la concentración molar del 

antagonista que hace necesario duplicar la concentración de agonista para obtener 

el mismo efecto que cuando el antagonista no está presente (Arunlakshana & Schild, 

1959; Schild, 1947).  

El procedimiento para calcular dicho valor consiste en tener valores amplios de 

logaritmos de razones de dosis representados en el eje de las ordenadas frente al 

logaritmo negativo de la concentración molar del antagonista en el eje de las 

abscisas, teniendo una recta cuya interpolación en el eje de las abscisas proporciona 

la medida del pA2 (Aronson, 2007; Arunlakshana & Schild, 1959; Schild, 1947). 

1.3 ESTRUCTURA Y FISIOLOGÍA DEL ÍLEON DE COBAYO 

El intestino delgado es donde ocurre la mayor parte de absorción de nutrientes y 

fármacos, ya que tiene una gran área superficial llena de vellosidades compuestas 

de una gran variedad de células desde su estructura, forma y tamaño. El íleon posee 

una pared vascular más delgada que el yeyuno y el duodeno, encontrándose en la 

parte distal del intestino delgado (Gabella, 1972; Kararli, 1995).  

El sistema nervioso entérico (SNE) coordina y modula las funciones musculares, 

vasculares, inmunes y endocrinas, entre otras, esenciales en la digestión. La mayoría 

de las neuronas involucradas en las funciones musculares se encuentran en el plexo 

mientérico y submucoso (Figura 1) (Costa et al., 2000). 
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Figura 1. Intestino delgado, obras de arte. [Fotografía]. Obtenido de Encyclopædia Britannica ImageQuest. 

https://imagequest.uam.elogim.com/search/132_1483075/1/132_1483075/cite  

Las células nerviosas del sistema nervioso simpático (SNS) en el intestino son 

diferentes de acuerdo con su localización, forma, proporción, conexión y función 

(Figura 2); son sensibles a estimulaciones químicas y mecánicas, inervan los plexos 

entéricos y las zonas vasculares de las submucosas (Costa et al., 2000; Nasser et al., 

2006).  

Los receptores adrenérgicos, α-adrenorecepectores y β-adrenoreceptores, son 

receptores acoplados a una proteína G. La liberación de los neurotransmisores, como 

la noradrenalina que se une a los receptores α2-adrenérgicos y β-adrenérgicos, se 

regula por medio del SNS. La pre-sinapsis de los adrenoreceptores α2a en el plexo 

mientérico, hiperpolariza las terminales nerviosas e inhiben la liberación de 

noradrenalina y acetilcolina, haciendo que la noradrenalina no pueda ejercer su 

efecto de relajación en las células del músculo liso en los β-adrenoreceptores (Nasser 

et al., 2006). 

https://imagequest.uam.elogim.com/search/132_1483075/1/132_1483075/cite


 

 

8 
 

 

 

Figura 2. Clases de neuronas mientéricas. LM, músculo longitudinal; CM, músculo circular; MP, plexo mientérico; SMP, 

plexo submucoso; AN, neuronas ascendentes; IN, neuronas intestinofugales; DIN, interneuronas descendentes; EPAN, 

neuronas aferentes primarias entéricas; EMN, motoneuronas excitatorias; IMN, motoneuronas inhibitorias; LMMN, 

motoneuronas longitudinales. Modificado de ((Costa et al., 1996)). 

1.4 PASOS PARA INSTALAR EL PROGRAMA OBsim 

El programa OBSim fue diseñado por la Universidad de Strathclyde con el fin de 

proveer un simulador que cumpliera con los requisitos de estos experimentos y de 

manera gratuita. 

Los requisitos mínimos que requiere el sistema son: 

Sistema Operativo: Windows XP o superior 

Procesador: Pentium 233 mHz o superior 

Memoria: al menos 1 GB RAM 

Gráficos: Tarjeta integrada gráfica o superior 

Almacenamiento: al menos 50 MB 

1.4.1 Acceder a la siguiente liga de internet dando clic en el enlace: 

https://spider.science.strath.ac.uk/sipbs/software_sims.htm  

Lo que conducirá a la siguiente pantalla: 

https://spider.science.strath.ac.uk/sipbs/software_sims.htm
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Si el enlace no funciona, buscar en Google o cualquier motor de búsqueda lo 

siguiente: “OBSim strathclyde university”, lo cual hará que aparezca la siguiente 

pantalla: 

 



 

 

10 
 

 

A continuación, dar clic donde se encuentra señalado (flecha roja) o en la primera 

opción que aparezca para llegar a la imagen del punto 1.4.1. 

1.4.2 Una vez dentro de la página de la Universidad de Strathclyde, ubicar el 

programa de OBSim: Organ Bath Simulation en el apartado de Simulations. A 

continuación, dar clic al enlace llamado Installation file (v3.6 05/01/21) (flecha roja). 

Nota: Actualmente, se encuentra disponible la versión v4.1 23/08/22, ésta 

únicamente añade un instalador para equipos Macintosh, por lo que sí se dispone 

de dicho sistema operativo puede utilizarlo; en este manual se trabajará con la 

versión estable v3.6 05/01/21 del programa en Windows ya que la versión de 

Windows que viene en el apartado v4.1 23/08/22 puede que arroje un problema al 

momento de descargarlo y sea más complicada su instalación. 
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1.4.3 Aparecerá la siguiente pantalla donde se puede descargar el instalador del 

programa haciendo clic en el apartado “ObSim.V3.6.Setup.exe” (flecha roja): 

 

1.4.4 A continuación (dependiendo del explorador utilizado para descargar el 

programa) ubicar el instalador descargado en el acceso directo del mismo 

explorador (imagen con margen rojo). 

 

O en la carpeta designada para descargas del explorador (imagen con margen azul). 
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1.4.5 Dar doble clic a la aplicación llamada “ObSim.V3.6.Setup” que se acaba de 

descargar y se ubica en la carpeta de “Descargas”. Dependiendo del sistema 

operativo y los permisos de usuario, puede que aparezca la siguiente imagen, la cual 

aparece por falta de los permisos antes mencionados. Si es el caso simplemente dar 

clic en el botón “Sí” (flecha roja). 
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1.4.6 El instalador del programa se hará presente, las indicaciones se encuentran 

en inglés. En la misma ventana, dar clic en el apartado “Next” (flecha roja) para 

continuar, ya que esta pantalla solo es la bienvenida al instalador del programa. 
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1.4.7 Seguido, aparecerá el apartado donde propone instalar el programa, por 

defecto se deja la ruta “C:\Program Files\OBSim” la cual instala el programa en una 

carpeta que se genera automáticamente en el Disco Local C, el cual es el 

predeterminado, generalmente en cualquier sistema operativo Windows, a menos 

que se tenga algún otro seleccionado. Si no se desea instalar en la ruta 

predeterminada, elegir la carpeta donde requiera instalar el programa [recuadro 

azul] (la carpeta OBSim se generará automáticamente una vez que se introduzca la 

nueva ruta). Una vez introducida la nueva ruta o dejado la predeterminada, dar clic 

en el apartado “Next” (flecha roja). 
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1.4.8 La siguiente pantalla solicita que introduzca un nombre para un grupo de 

programas, el cual por defecto es “OBSim” si se desea colocar uno distinto, escribir 

en el recuadro azul el nombre deseado. Para crear un acceso directo para todos los 

usuarios que hagan uso de ese equipo de cómputo, dar clic en el recuadro rojo o 

únicamente para el usuario que está instalando el programa actualmente dar clic en 

el recuadro verde. Dar clic en “Next” para continuar (flecha roja). 
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1.4.9 La siguiente ventana simplemente notifica que se harán los cambios 

seleccionados anteriormente. Dar clic en “Next” para continuar (flecha roja). 
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1.4.10 Dependiendo de la velocidad del equipo de cómputo, el asistente de 

instalación procederá a instalar el programa de acuerdo con las opciones 

seleccionadas anteriormente. Una vez que concluya la instalación aparecerá la 

siguiente pantalla la cual permite cerrar el asistente de instalación y ejecutar el 

programa directamente una vez se cierre el asistente (recuadro azul). Para no 

ejecutar el programa directamente, desactivar la casilla “Run OBSim now”. A 

continuación, dar clic en “Finish” para terminar la instalación y cerrar el asistente de 

instalación del programa (flecha roja). 

 

1.4.11 En el escritorio se habrá generado un acceso directo, el cual ejecuta 

directamente el programa 

 
Si no se encuentra el acceso directo, ir a la ruta establecida en el punto 1.4.7 para 

instalar el programa, en la cual se dispone el acceso a la aplicación (flecha roja). 
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1.5.2 

1.5.3 

1.5.4 

1.5.5 

1.5.1 

 

1.5 PARTES INTEGRALES DEL PROGRAMA OBSim: Organ Bath 

Simulation 

El programa OBSim: Organ Bath Simulation está compuesto de diversas funciones 

que ayudan a simular un experimento farmacológico con órgano aislado. La 

siguiente imagen expone las partes por las que se compone el programa; se verán 

detalladamente más adelante: 

 

 

1.5.6 1.5.7 

1.5.8 

1.5.9 1.5.10 

1.5.11 1.5.12 1.5.13 
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1.5.1 Pestañas de operación: La pestaña File desplegará un menú que permite 

crear un nuevo experimento (New Experiment), cargar un experimento (Load 

Experiment), guardar un experimento (Save Experiment), Imprimir (Print) y Salir 

del programa (Exit). 

 
La pestaña Edit permitirá copiar la información que se ejecuta (Copy Data) y copiar 

la información que se tenga actualmente en el gráfico (Copy Image). 

 
La pestaña Help desplegará la opción de ir a los contenidos referentes al programa 

(Contents). Estos se encontrarán en idioma inglés. 

 

1.5.2 Tipo de Tejido: Se muestra el tipo de tejido seleccionado de entre los 

disponibles en el programa. 

 

1.5.3 Nuevo experimento: Al dar clic en el botón New Experiment, se desplegará 

un menú el cual permite seleccionar el tipo de tejido aislado con el que se desee 

trabajar.  
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1.5.4 Estimulación eléctrica: El apartado permite seleccionar la estimulación que 

se le dará a las fibras nerviosas que inervan el tejido muscular dejando seleccionada 

la opción de Nerve, o Muscle para estimular directamente las fibras musculares 

dentro del tejido. 

 

1.5.5 Agonistas: El apartado muestra todos los agonistas disponibles en el 

programa, junto con la concentración molar de la solución stock a trabajar y el 

volumen a añadir al Baño de órgano. Realizar los siguientes pasos para seleccionar un 

agonista: 

1.5.5.1 Seleccionar el apartado de Agonistas. 

 

1.5.5.2 Seleccionar el tipo de agonista a usar disponibles de la lista. 
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1.5.5.3 Seleccionar la concentración del agonista a utilizar disponibles de la lista. 

 

1.5.5.4 Colocar el volumen deseado (entre 0 a 1 ml) de la solución stock en la caja de 

Volumen. 

1.5.5.5 Hacer clic en Add to Organ Bath para añadir el volumen y concentración 

previamente seleccionados al baño de órgano. 

1.5.6 Antagonistas: El apartado muestra todos los antagonistas disponibles en el 

programa, junto con la concentración molar de la solución stock a trabajar y el 

volumen a añadir al Baño de órgano o Reservorio. Realizar los siguientes pasos para 

seleccionar un antagonista: 

1.5.6.1 Seleccionar el apartado de Agonistas. 

 

1.5.6.2 Seleccionar el tipo de agonista a usar disponibles de la lista. 
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1.5.6.3 Seleccionar la concentración del antagonista a utilizar disponibles de la lista. 

 

1.5.6.4 Colocar el volumen deseado (entre 0 a 1 ml) de la solución stock en la caja de 

Volumen. 

1.5.6.5 Hacer clic en Add to para añadir el volumen y concentración previamente 

seleccionados al baño de órgano o reservorio. 

1.5.6.6 Seleccionar Organ Bath de la lista de Add To para que el volumen y 

concentración del antagonista seleccionado sea aplicado directamente al Baño de 

órgano. Seleccionar Reservoir para añadir el antagonista al reservorio que contiene 

la solución de Krebs. 
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1.5.7 Desconocidos: El apartado muestra diversos fármacos que pueden actuar 

como agonistas, antagonistas o puede que no tengan actividad en los tejidos de los 

que dispone el programa. Para experimentar con ellos, se puede seguir la misma 

metodología de los puntos 1.5.6 a 1.5.6.6. 

 

1.5.8 Reservorio: El apartado muestra las opciones Flush Reservoir to Bath y Clear 

Drugs from Res. La primera agrega el contenido del Reservorio el cual puede contener 

principalmente la solución de Krebs-Henseleit (normal) y algún antagonista o 

fármaco desconocido que se haya agregado al Baño de órgano. La segunda elimina el 

antagonista o fármaco desconocido que se le haya agregado al Reservorio para dejar 

libre la solución de Krebs. 

1.5.9 Registrar: Al hacer clic en el botón Record se comenzará el experimento con 

las condiciones anteriormente seleccionadas y se iniciará el registro en el apartado 

de Gráfico (Chart). 

 

1.5.10 Detener: Al hacer clic en el botón Stop se detendrá el experimento. 
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1.5.11 Gráfico: La pestaña Chart muestra el gráfico de la respuesta del órgano 

aislado correspondiente al tiempo en el eje de las abscisas y la fuerza (gms) en el eje 

de las ordenadas. Se dispone de más información la cual se explica a continuación: 

1.5.11.1 En el gráfico se muestra la respuesta obtenida (flecha azul), el registro 

el cual equivale a la Fuerza en gramos (flecha verde), la concentración de agonista 

utilizada en el tiempo correspondiente (flecha negra), cuando se realizó el lavado 

con la solución de Krebs o la concentración de antagonista o fármaco desconocido 

en la misma (flecha roja), el tiempo inicial en que se mostrará el gráfico (flecha 

naranja) y el tamaño de ventana equivalente al tiempo que se desea visualizar 

(flecha amarilla). 
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1.5.12 Configuración experimental: Dependiendo del tipo de tejido, se mostrará 

una representación del experimento real que incluye un registrador gráfico (Chart 

Recorder), fuerza del transductor (Transductor Force), estimulador (Stimulator), 

jeringa con antagonista (Antagonist Syringe (1 ml)), jeringa con agonista (Agonist 

Syringe (1 ml)), tejido (Tissue), válvula (Valvle), reservorio de Krebs (1000 ml Krebs 

Reservoir), baño de órgano (10 ml organ bath), desbordamiento o desecho 

(Overflow), baño de agua calentada (Heated Water Bath) y el drenado (Drain). 

 

1.5.13 Fórmula de dilución: Al momento de añadir un fármaco al baño de órgano, 

la concentración final del baño [CFB] en molaridad (M) se encuentra relacionada con 

la concentración de la solución stock (M), el volumen del stock añadida al baño (ml) 

y el volumen del baño (ml) dada la siguiente ecuación: 

[𝑪𝑭𝑩] =
[𝒔𝒕𝒐𝒄𝒌] × 𝑽𝒐𝒍𝒖𝒎𝒆𝒏 𝒅𝒆 𝒔𝒕𝒐𝒄𝒌 𝒂ñ𝒂𝒅𝒊𝒅𝒐

𝑽𝒐𝒍𝒖𝒎𝒆𝒏 𝒅𝒆𝒍 𝒃𝒂ñ𝒐
 

El simulador permite la obtención de cualquier valor de la ecuación, siendo el 

volumen de la solución stock la incógnita más notable. 
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Para determinar este valor en el simulador, realizar los siguientes pasos: 

1.5.13.1 Seleccionar la pestaña de Dilution Formula y en el apartado de Result 

seleccionar Volume to Add (volumen por añadir). 

 

1.5.13.2 Ingresar el volumen del baño de órgano (10 ml) o reservorio (1000 ml) 

según sea el caso, en la caja de Bath Volume (ml). 

 

1.5.13.3 Ingresar la concentración final del baño requerida en la caja de Final 

Bath Conc. (M). 

 

1.5.13.4 Ingresar la concentración de la solución stock en la caja Stock Soln. 

Conc. (M). 

 

1.5.13.5 Una vez que se tengan los datos anteriores, dar en el botón Calculate 

para calcular el resultado final; este será el volumen necesario por añadir en el baño 

de órgano o reservorio. 

 

1.6 EJEMPLO 

Schaumann (1956), realizó un experimento con Atropina en diversas partes del 

intestino de cobayo, entre ellas el íleon. Él observó que la distensión del lumen 

también lleva a la contracción del músculo longitudinal por presencia de 
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acetilcolina. ¿Cuál será el efecto de la acetilcolina sobre el íleon de cobayo en el 

simulador de órgano aislado? ¿Cuál es la dosis efectiva 50 de la acetilcolina? ¿Qué 

le sucede al efecto de la acetilcolina en presencia de la atropina? ¿Cuál es el valor de 

pA2 de la atropina? 

1.6.1 Para formular el experimento y tener una idea de lo que Schaumann pudo 

observar, con ayuda del programa OBSim Simulator y una hoja de datos de 

Microsoft® Excel, después de haber instalado el programa como en los puntos 1.4 a 

1.4.11 de este manual, seguir los pasos de los puntos 1.5.2 a 1.5.4 para colocar el 

experimento en nervio en íleon de cobayo. 

1.6.2 Utilizar valores de ¼ de logaritmo, ½ de logaritmo y 1 logaritmo base 10 de 

forma ascendente para calcular las concentraciones de acetilcolina, quedando de la 

siguiente manera (Tabla 1): 

Tabla 1. Concentración molar deseada de acetilcolina a utilizar en íleon de cobayo. 

Concentración 

deseada de 

ACh(M) 

1.00E-09 

3.00E-09 

6.00E-09 

1.00E-08 

3.00E-08 

6.00E-08 

1.00E-07 

3.00E-07 

6.00E-07 

1.00E-06 

3.00E-06 

6.00E-06 
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1.6.3 Con las concentraciones de la Tabla 1, calcular los volúmenes por agregar con 

la fórmula de dilución (punto 1.5.13) para lograr las concentraciones deseadas, 

recordar que el volumen máximo por añadir debe ser de 1.00 ml. En la siguiente 

imagen se ejemplifica el primer volumen por agregar con la fórmula de dilución, 

quedando de la siguiente manera: 

 

En la Tabla 2, el volumen por agregar (1 ml) de acetilcolina a partir de una solución 

stock con concentración de 1E-08 M para tener una concentración deseada de 1E-09 M, 

coincide con la calculada en la fórmula de dilución mostrada en la imagen previa. 

Los demás valores se han calculado siguiendo el mismo método, corroborar los 

datos de acuerdo con punto 1.6.3. 

Tabla 2. Volúmenes por agregar de acetilcolina a partir de una concentración stock para lograr una concentración deseada. 

Concentración 

deseada ACh(M) 

Concentración 

Solución stock ACh 

(M) 

Volumen por agregar 

ACh (ml) 

1.00E-09 1E-8 1.00 

3.00E-09 1E-7 0.30 

6.00E-09 1E-7 0.60 

1.00E-08 1E-7 1.00 

3.00E-08 1E-6 0.30 

6.00E-08 1E-6 0.60 

1.00E-07 1E-6 1.00 

3.00E-07 1E-5 0.30 

6.00E-07 1E-5 0.60 

1.00E-06 1E-5 1.00 

3.00E-06 1E-4 0.30 

6.00E-06 1E-4 0.60 
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1.6.4 Una vez obtenidos los volúmenes necesarios para comenzar el experimento, 

dar clic en Record, lo cual iniciará el trazo de la respuesta en la pestaña de chart. 

1.6.5 Iniciado el trazo de la respuesta en el gráfico, añadir los valores calculados de 

volúmenes necesarios de acetilcolina de acuerdo con la Tabla 2. 

Comenzando por el primer volumen, dar clic en Add to Organ Bath para añadir el 

primer valor de volumen de acetilcolina; concorde a la Tabla 2, este valor será de 1 

ml. La concentración de acetilcolina utilizada se observará en la parte inferior del 

gráfico (punto 1.5.11.1). 

1.6.6 Dejar actuar por 20 segundos o el tiempo considerado para observar una 

respuesta y posteriormente dar clic en Flush Reservoir to Bath para eliminar la 

concentración añadida de acetilcolina en el punto 1.6.5. 

1.6.7 Proseguir con el siguiente volumen calculado en la Tabla 2. Añadir 0.30 ml de 

una concentración stock de 1E-07 M para obtener una concentración deseada de 3E-09 

M de acetilcolina dando clic en Add to Organ Bath, esperar un tiempo considerable 

para observar la respuesta y eliminar la concentración añadida dando clic en Flush 

Reservoir to Bath, así sucesivamente hasta terminar con los valores de la Tabla 2. 

En resumen: 

a) Calcular los valores de volumen por agregar de acetilcolina con respecto a una 

solución stock para lograr una concentración deseada. 

b) Colocar en la caja de agonista a Acetylcholine, en la caja de Stock Soln 1E-8 M y en la 

caja de Volume 1.00 ml. 

c) Dar clic en Record para comenzar el experimento. 

d) Dar clic en Add to Organ Bath para añadir los volúmenes anteriormente calculados. 

e) Observar la respuesta que ejerza la concentración seleccionada y dejar que actué 

aproximadamente 20 segundos, dependiendo del criterio para observar una 

respuesta. 

f) Dar clic en Flush Reservoir to Bath para eliminar la concentración de acetilcolina 

presente y poder proseguir con el siguiente valor; en este caso, colocar en la caja de 

Stock Soln. 1E-07 y en la caja de Volume 0.30 ml, eliminar la concentración una vez se 

haya observado una respuesta y continuar con el siguiente volumen calculado hasta 

llegar a una gráfica como la siguiente: 
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1.6.8 Para determinar la respuesta, se cuenta con una línea verde en la pestaña de 

chart, la cual se puede mover libremente dando y manteniendo clic con el cursor 

sobre la misma, proporcionará los datos de fuerza en gramos de acuerdo a donde 

sea colocada: 

 

F 

     5 gms 

100 s

Ach 1.0E-9 M

Wash ()

Ach 3.0E-9 M

Wash ()

Ach 6.0E-9 M

Wash ()

Ach 1.0E-8 M

Wash ()

Ach 3.0E-8 M

Wash ()

Ach 6.0E-8 M

Wash ()

Ach 1.0E-7 M

Wash ()

Ach 3.0E-7 M

Wash ()

Ach 6.0E-7 M

Wash ()

Ach 1.0E-6 M

Wash ()

Ach 3.0E-6 M

Wash ()

Ach 6.0E-6 M
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1.6.9 Una vez que se tengan las respuestas registradas, se procederá a llenar la 

siguiente tabla (Tabla 3), quedando de la siguiente manera para uso de este ejemplo: 

Tabla 3. Respuesta generada por acetilcolina en íleon de cobayo respecto a una concentración deseada. 

Concentración 

deseada ACh(M) 

Acetilcolina respuesta 

(g) 

1.00E-09 0.24426 

3.00E-09 0.93796 

6.00E-09 1.6023 

1.00E-08 2.5403 

3.00E-08 5.0708 

6.00E-08 8.2755 

1.00E-07 9.7411 

3.00E-07 11.793 

6.00E-07 12.1784 

1.00E-06 12.78 

3.00E-06 13.004 

6.00E-06 13.112 

1.6.10 Con estos datos se puede graficar la respuesta frente a la concentración de la 

siguiente manera: 

 

Gráfico 1. Respuesta generada por una concentración deseada de acetilcolina en íleon de cobayo. 
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1.6.11 Para obtener una línea de tendencia, la respuesta se pasa a porcentaje y la 

concentración se pasa a logaritmo base 10. Para calcular el porcentaje se toma como 

el 100% al valor más alto encontrado en la respuesta, quedando de la siguiente 

manera (Tabla 4): 

Tabla 4. Logaritmo base 10 de concentración deseada de acetilcolina y efecto en porcentaje de la respuesta generada. 

Concentración 

deseada ACh(M) 

Log10(M) Acetilcolina 

respuesta (g) 

Efecto (%) 

1.00E-09 -9 0.24426 1.862873703 

3.00E-09 -8.522878745 0.93796 7.153447224 

6.00E-09 -8.22184875 1.6023 12.22010372 

1.00E-08 -8 2.5403 19.37385601 

3.00E-08 -7.522878745 5.0708 38.67297132 

6.00E-08 -7.22184875 8.2755 63.11394143 

1.00E-07 -7 9.7411 74.29148871 

3.00E-07 -6.522878745 11.793 89.94051251 

6.00E-07 -6.22184875 12.1784 92.87980476 

1.00E-06 -6 12.78 97.46796827 

3.00E-06 -5.522878745 13.004 99.17632703 

6.00E-06 -5.22184875 13.112 100 

Graficando únicamente los valores de Log10 (M) y Efecto (%) de la Tabla 4, se 

obtiene la siguiente gráfica: 

 

Gráfico 2. Log10 de concentración deseada de acetilcolina frente a efecto observado en porcentaje. 

y = 31.457x + 280.78
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1.6.12 Para obtener la Dosis efectiva 50 (DE50), se debe interpolar con la ecuación de 

la recta el valor deseado para así conocer la concentración cuando se tiene un 50% 

de efecto. Para este ejemplo se calculará de la siguiente manera: 

𝑥 =
(50 − 280.78)

31.457
= −7.3364 

1.6.13 Recordar que se está calculando con base a la línea de tendencia que se obtuvo 

por el porcentaje de respuesta y el logaritmo de la concentración, por lo que el valor 

de X estará dado en logaritmo. Para obtener el valor real de la concentración, se debe 

calcular el antilogaritmo del valor dado; en este caso: 

10−7.3364 =  4.60931𝐸-08 

Comprobado que la acetilcolina tiene un efecto en el íleon de cobayo, ahora se añade 

atropina al experimento. 

Para este punto, añadir la concentración de 1 nM, 5 nM y 10 nM de atropina al 

reservorio. Únicamente se ejemplifica la primera concentración (1 nM), pero el 

procedimiento es el mismo para los dos siguientes. 

1.6.14 Siguiendo la misma metodología del punto 1.6.3 de este ejemplo, calcular el 

volumen por añadir de antagonista (Atr) al reservorio según la concentración 

deseada quedando de la siguiente manera; en la imagen se ejemplifica el primer 

volumen: 

Nota: Observar que el valor dado en la caja de Bath Volume (ml) ahora es 1000 ml ya 

que se calcula para reservorio y no para baño de órgano (10 ml). 

 

Tabla 5. Volúmenes por agregar de atropina a partir de una concentración stock para lograr una concentración deseada. 

Concentración 

deseada Atr(M) 

Concentración 

Solución stock Atr (M) 

Volumen por agregar 

Atr (ml) 

1.00E-09 1E-6 1.00 

5.00E-09 1E-5 0.50 

10.00E-08 1E-5 1.00 
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1.6.15 La Tabla 5 muestra los valores calculados de los volúmenes por añadir al 

Reservorio para obtener la concentración deseada de atropina. Se trabaja con las 

mismas concentraciones de acetilcolina (1.00E-9, 3.00E-9, … 6.00E-6), tener en cuenta 

que la atropina se encuentra en el medio de lavado, por lo que se comienza el 

experimento como en el punto 1.6.4 de este ejemplo y antes de añadir el agonista 

(acetilcolina) realizar un lavado con el antagonista (atropina) encontrado en el 

reservorio. Se ilustra el inicio antes mencionado: 

 
Observar que se tiene un lavado con el antagonista (flecha y recuadro rojo) antes de 

administrar el agonista (flecha y recuadro azul). Continuar como en los puntos 1.6.5 

a 1.6.7 de este ejemplo teniendo en cuenta que se trabaja con las concentraciones 

calculadas de atropina en el reservorio (Tabla 5). 

El gráfico 3 ilustra únicamente los resultados de respuesta de acetilcolina en 

presencia de la primera concentración de atropina (Atr 1 nM) comparado con el 

Gráfico 1 del punto 1.6.10 de este ejemplo. 

Realizar la misma metodología con los valores de atropina restantes de la Tabla 5 

(Atr 5nM y Atr 10nM). 

 

Gráfico 3. Respuesta de acetilcolina en presencia de atropina 1nM. 
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1.6.16 Al igual que con la acetilcolina, para obtener una línea de tendencia se 

grafican las concentraciones del agonista en logaritmo base 10 y el porcentaje de la 

respuesta observada en el simulador como en el punto 1.6.11 de este ejemplo. 

Posteriormente, calcular la DE50 como en el punto 1.6.12 de este ejemplo para las tres 

concentraciones definidas de atropina (Tabla 5). 

1.6.17 Calcular las DE50 de agonista solo (A), y la DE50 del agonista en presencia de 

antagonista (A’), así como la Razón de dosis (punto 1.6.18). 

Una vez obtenidos los datos anteriores, se pueden organizar como en la Tabla 6, la 

cual únicamente ejemplifica la DE50 del agonista en presencia de antagonista (A´), 

por lo que se debe calcular la DE50 del agonista solo. 

Tabla 6. Concentración y respuesta de acetilcolina en presencia de atropina 1nM considerando el efecto en porcentaje y la 

dosis efectiva 50 en molaridad. 

Concentración 

ACh(M) 

Respuesta ACh 

con Atr 1nM en 

Res. 

Efecto (%) DE50 (M) A’ 

1.00E-09 0.10747 0.819630872 7.65653E-08 

3.00E-09 0.38105 2.906116534 
 

6.00E-09 0.83048 6.333740085 
 

1.00E-08 1.5535 11.84792556 
 

3.00E-08 3.8007 28.98642465 
 

6.00E-08 5.5496 42.32458816 
 

1.00E-07 7.6014 57.9728493 
 

3.00E-07 10.708 81.66564979 
 

6.00E-07 11.773 89.78798048 
 

1.00E-06 12.008 91.58023185 
 

3.00E-06 12.985 99.0314216 
 

6.00E-06 13.111 99.9923734 
 

1.6.18 Con los datos de las DE50 se obtiene la razón de dosis de la siguiente manera: 
𝐴′

𝐴
=

7.65653𝐸 − 08

4.6093𝐸 − 08
= 1.661100366 

El valor de A’ es la DE50 de la concentración del agonista (ACh) en presencia de 

antagonista (Atr) (Tabla 6) y el valor de A es la DE50 de la concentración de agonista 

(ACh) solo, es decir, sin ningún antagonista presente. El valor de A´ debe obtenerse 

tres veces debido a las tres concentraciones diferentes de antagonista con las que se 

trabaja (Atr 1nM, 5nM y 10nM). 
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1.6.19 Ahora se tienen los valores suficientes para poder calcular el valor de pA2. Se 

muestra la Tabla 7 con las dosis de atropina añadidas, razón de dosis, y valores 

necesarios para encontrar el valor de pA2, y el Gráfico 4 correspondiente a la 

representación de Schild, la cual provee una ecuación de la recta obteniendo la 

ordenada al origen que concierne al valor pA2 buscado: 

Tabla 7. Dosis de antagonista, razón de dosis, logaritmo negativo base 10 de la dosis del antagonista y logaritmo base 10 

de la razón de dosis junto con el valor pA2. 

Dosis de 

Antagonista Atr M 

(B) 

A'/A (-) log B log (A'/A -1) pA2 

1.00E-09 1.661100366 9 0.179732603 7.4088 

5.00E-09 3.598649751 8.301029996 0.414747749 
 

1.00E-08 5.588919537 8 0.661710443 
 

 

Gráfico 4. Representación de Schild para el cálculo de pA2. 

Tomar en cuenta que se están graficando los valores de log(A’/A-1) logaritmo base 10 

de Razón de dosis y -log B logaritmo negativo base 10 de concentración de dosis de 

antagonista, para obtener una ecuación de la recta. La ordenada al origen será el valor 

de pA2 buscado. 

1.7 EJERCICIOS 

1) Hill y colaboradores (1977) describieron la unión especifica de mepiramina a 

receptores histamínicos en el musculo mientérico del plexo longitudinal de intestino 

de cobayo. Descubrieron que existe una unión especifica a estos receptores. 

a) ¿Cómo elaboraría su propio experimento para determinar que hay una relación 

entre la mepiramina y los receptores histamínicos? Para esta pregunta considere las 

concentraciones de agonista de la Tabla 1 (1.00E-9, 3.00E-9, … 6.00E-6), y de 

antagonista de la Tabla 5 (1.00E-09, 5.00E-09, 10.00E-08) del ejemplo del punto 1.6. 

y = -0.843x + 7.4088
R² = 0.9999
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b) ¿Se presenta algún tipo de antagonismo entre la mepiramina y la histamina? ¿De 

qué tipo? 

c) ¿Cuál es la DE50 de la histamina? 

d) ¿Cuáles son los valores de DE50 de la mepiramina y las razones de dosis? 

e) ¿Cuál es el valor de pA2 de la mepiramina? Explica el significado de este valor. 

 

2) Ward & Takemori (1976) midieron la tolerancia que ejercía la morfina en el íleon de 

cobayo estimulándolo para lograr una visualización de los resultados. Consideraron 

a la naloxona como antagonista. 

a) ¿Cómo elaboraría su propio experimento para corroborar que hay una relación entre 

la morfina y los receptores narcóticos? Para esta pregunta considere las 

concentraciones de agonista de la Tabla 1 (1.00E-9, 3.00E-9, … 6.00E-6), y de 

antagonista de la Tabla 5 (1.00E-09, 5.00E-09, 10.00E-08) del ejemplo del punto 1.6. 

b) ¿Qué tipo de antagonismo se presenta entre la morfina y la naloxona? 

c) ¿Cuál es la DE50 de la histamina? 

d) ¿Cuáles son los valores de DE50 de la morfina y las razones de dosis? 

e) ¿Cuál es el valor de pA2 de la naloxona? Explica el significado de este valor. 

 

3) A un estudiante de QFB de la Universidad Autónoma Metropolitana Unidad 

Xochimilco, le pidieron realizar un experimento con toxina botulínica B para 

corroborar si se unía a diferentes receptores encontrados en el íleon de cobayo. Se 

pidió que se utilizara como agonista y antagonista en diversos casos. Para el primer 

caso utilice cualquiera de los 5 antagonistas encontrados en el programa OBSim. 

Para el segundo caso utilice cualquiera de los 7 agonistas encontrados en el 

programa OBSim. 

a) De acuerdo con el antagonista que haya elegido ¿Cómo elaboraría su propio 

experimento para utilizar a la toxina botulínica B como agonista? Para esta pregunta 

considere las concentraciones de agonista de la Tabla 1 (1.00E-9, 3.00E-9, … 6.00E-6), 

y de antagonista de la Tabla 5 (1.00E-09, 5.00E-09, 10.00E-08) del ejemplo del punto 

1.6. 

b) ¿Se presenta algún tipo de antagonismo entre la toxina botulínica B y el antagonista 

seleccionado? ¿De qué tipo? 

c) ¿Cuál es la DE50 de la toxina botulínica B? 

d) ¿Cuáles son los valores de DE50 de la toxina botulínica B y las razones de dosis? 

e) ¿Cuál es el valor de pA2 del antagonista seleccionado? Explica el significado de este 

valor. 
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f) De acuerdo con el agonista que haya elegido ¿Cómo elaboraría su propio 

experimento para utilizar a la toxina botulínica B como antagonista? Para esta 

pregunta considere las concentraciones de agonista de la Tabla 1 (1.00E-9, 3.00E-9, 

… 6.00E-6), y de antagonista de la Tabla 5 (1.00E-09, 5.00E-09, 10.00E-08) del ejemplo 

del punto 1.6. 

g) ¿Se presenta algún tipo de antagonismo entre la toxina botulínica B y el agonista 

seleccionado? ¿De qué tipo? 

h) ¿Cuál es la DE50 del agonista seleccionado? 

i) ¿Cuáles son los valores de DE50 del agonista seleccionado y las razones de dosis? 

j) ¿Cuál es el valor de pA2 de la toxina botulínica B? Explica el significado de este valor.  
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Capítulo 2. DOCKING MOLECULAR ENTRE AINEs Y COXs CON 

AUTODOCK VINA EN WINDOWS 10. 

Al hablar del desarrollo de nuevos fármacos, generalmente se siguen utilizando 

estudios de seguridad y eficacia basados en la experimentación animal. 

Desafortunadamente, este tipo de experimentación conlleva problemas desde 

costos, problemas éticos y morales, tiempo y la seguridad y eficacia en términos 

prolongados. Según la FDA (Food and Drug Administration) más del 90 por ciento 

de moléculas nuevas con presunta actividad farmacológica llegan a ser rechazadas, 

ya que mostraron buena actividad en animales, pero cuando son aplicadas en 

humanos pueden llegar a mostrar diferentes efectos. El alto índice de enfermedades, 

resistencia microbiana, aparición de nuevos virus, entre otras, hacen que cada día se 

propongan nuevos fármacos, por lo que las problemáticas de los métodos 

tradicionales de experimentación animal hacen que estos sean más complicados de 

llevar a cabo. (Burke et al., 2007; Doke & Dhawale, 2015; Lipinski et al., 2001). Así ha 

ido creciendo el interés de desarrollar aproximaciones farmacológicas que reduzcan, 

refinan o reemplacen estos métodos para salvar tiempo y dinero en el proceso del 

desarrollo farmacéutico (Balls, 1994; Sliwoski et al., 2014). 

En farmacología, el docking es una alternativa in silico a las problemáticas con los 

métodos de experimentación animal, ya que permite predecir la afinidad entre 

ligandos y receptores en el sitio de acción de estos (Ekins et al., 2007). El docking es 

un método que estima la orientación preferida por un ligando entre varias 

orientaciones al momento de establecer un complejo con un receptor y buscar la 

conformación más estable (Figura 3), convirtiéndose así en uno de los métodos más 

frecuentemente utilizados en el desarrollo farmacéutico en etapas tempranas, 

debido a su habilidad de predecir dichas conformaciones y afinidades (Gohlke et al., 

2000; Leach et al., 2006). 

 

Figura 3. Resumen abstracto de la técnica de Docking. Extraído de (Gupta et al., 2018). 

Diversas instituciones tanto académicas como gubernamentales promueven el 

desarrollo y uso del docking durante el proceso de desarrollo de fármacos. Se puede 
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ver su aplicación por los artículos publicados acerca del mismo (Figura 4). Así 

diversos fármacos pueden ser evaluados en ámbitos como seguridad y eficacia a 

costos menores en breves periodos de tiempo (Chen & Zhi, 2001; Festing, 1994). 

 

Figura 4. Número de artículos publicados del año 2000 a 2017. Información extraída de Pubmed. Modificado de (Gupta et 

al., 2018) 

Sin embargo, se deben tomar en cuenta diversos factores con respecto al docking 

como la delimitación exacta del sitio de acción del receptor, la posición u orientación 

del ligando y sobre todo pensar que únicamente se está estudiando la afinidad 

ligando-receptor, por lo que no es posible comprobar si funcionará como agonista, 

antagonista o si el tiempo que pueda durar esa interacción promueve alguna de estas 

reacciones (Abagyan & Totrov, 2001; Gupta et al., 2018; Klebe, 2006). 

2.1 CICLOOXIGENASAS (COX) 

Las prostaglandina-endoperóxido sintetasas (PGHSs), también conocidas como 

ciclooxigenasas (COXs), catalizan la conversión del ácido araquidónico a 

prostaglandinas H2, el precursor de prostaglandinas proinflamatorias y 

tromboxanos (Figura 5). Se han identificado dos isoformas de las COX derivadas 

COX-1 y COX-2. Estas intervienen en diversos eventos fisiológicos como regulación 

de funciones renales y mantenimiento de la mucosa estomacal (COX-1) al igual que 

desencadenan efectos como fiebre, inflamación y dolor (COX-2) (Chen, 2010; 

Kurumbail et al., 2001; Sidhu et al., 2010). 
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Figura 5. La abstracción de un hidrogeno al ácido araquidónico (AA) por la Tyr-385 de la ciclooxigenasa forma un radical, 

provocando la migración de este al C-11 del AA, lo que conlleva a la reacción con la ciclooxigenasa regenerando el radical 

y la formación de prostaglandinas (Rouzer & Marnett, 2009). Imagen recuperada de (Malkowski et al., 2000). 

La COX-1 es expresada en la mayoría de los tejidos ya que es requerida para la 

producción de prostaglandinas involucradas en diferentes funciones de 

mantenimiento a través del cuerpo. La COX-2 es una enzima inducible, encontrada 

principalmente en cerebro y riñones, la cual es expresada en respuesta de citocinas, 

mitógenos y endotoxinas (Luong et al., 1996; Picot et al., 1994). 

Estructuralmente ambas enzimas son muy parecidas, sin embargo, el sitio activo de 

la COX-2 es más largo y ligeramente diferente de la COX-1. Principalmente, se debe 

a la diferencia en tres aminoácidos: Ile523 por Val523, Ile423 por Val434 y His513 

por Arg513 en COX-1 y COX-2 respectivamente. 

Veinticuatro residuos de aminoácidos conforman el sitio activo de las COXs los 

cuales incluyen Leu117, Arg120, Phe205, Phe209, Val344, Ile345, Tyr348, Val349, 

Leu352, Ser353, Tyr355, Leu359, Phe381, Leu384, Tyr385, Trp387, Phe518, Ile/Val523 

(COX-1 y COX-2 respectivamente), Gly526, Ala527, Ser530, Leu531, Gly533 y Leu534 

(DeWitt & Smith, 1988; Lecomte et al., 1994; Loll et al., 1995; Luong et al., 1996; Picot 

et al., 1994). 

2.2 ANTIINFLAMATORIOS NO ESTEROIDEOS (AINEs) 

Los sitios activos de la COX-1 y COX-2 pueden ser inhibidos por la interacción de 

los antiinflamatorios no esteroideos (AINEs), los cuales compiten con el ácido 

araquidónico (Figura 6). La composición de los aminoácidos en el sitio de acción 

influye en la acción catalítica de las COX, por ejemplo, la Ser530 es el residuo por el 
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cual el ácido acetil salicílico (aspirina) realiza su acetilación inhibiendo su acción 

(DeWitt & Smith, 1988; Lecomte et al., 1994; Loll et al., 1995) y la Arg120 se une a los 

carboxilatos de ácidos grasos e igualmente a varios AINEs (DeWitt & Smith, 1988; 

Kalgutkar et al., 2000; Lecomte et al., 1994; Loll et al., 1995; Rowlinson et al., 1999; 

Rowlinson et al., 2003; Smith & Dewitt, 1996; Smith et al., 1996). 

 

Figura 6. Mecanismo de acción de los antiinflamatorios no esteroideos (AINEs). Modificado de (Green, 2001). 

Principalmente, existen dos puntos a tomar en cuenta al momento de hablar de 

AINEs. El primero, existen dos clases de AINEs: clásicos, que pueden inhibir COX-

1 y COX-2 por igual (<1995) (Laneuville et al., 1994) e inhibidores selectivos de COX-

2 (DeWitt, 1999; Rowlinson et al., 1999). 

El segundo, mientras que todos los AINEs por igual compiten con el ácido 

araquidónico por el sitio activo de las COX, cada AINE presenta un modo cinético 

diferente al momento de realizar su inhibición: (a) unión reversible (ibuprofeno); (b) 

unión lentamente reversible derivada por alta afinidad (flurbiprofeno); o (c) unión 

reversible seguida de una modificación covalente en algún residuo de aminoácido 

(casi siempre acetilación en Ser530) (aspirina) (DeWitt, 1999; Rowlinson et al., 1999; 

Smith & Dewitt, 1996; Smith et al., 2000; Smith et al., 1996). 

2.3 PROGRAMAS POR UTILIZAR Y SU INSTALACIÓN 

Para realizar el docking molecular se utilizarán diversos programas, enumerados en 

los siguientes puntos, los cuales son complementarios entre sí. 

Los requisitos mínimos que requiere el sistema son: 

Sistema Operativo: Windows 10 o posterior 

Procesador: Intel Core i5 5th gen/AMD Ryzen 3, o posterior 

Memoria: 4 Gb RAM, o superior 

Gráficos: Tarjeta integrada gráfica o superior 

Almacenamiento: 4 Gb o superior 
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2.3.1 Instalación del programa Avogadro (Hanwell et al., 2012)  

2.3.1.1 Acceder a la siguiente liga de internet dando clic en el enlace: 

https://avogadro.cc/  

Lo que conducirá a la siguiente pantalla: 

 

2.3.1.2 A continuación, dar clic en el apartado de “Download” (recuadro azul de la 

imagen del punto 2.3.1.1), lo que dirigirá a la siguiente pantalla: 

 

Automáticamente comenzará la descarga del archivo instalable “Avogadro-1.2.0n-

win32.exe” (no importa si se trabaja en un sistema operativo de 32 o 64 bits, correrá 

https://avogadro.cc/
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de la misma manera), visualizar en el sitio de descargas del explorador utilizado 

para internet: 

 

2.3.1.3 Si no se descarga por sí solo el archivo instalable, en la ventana del punto 

2.3.1.2, dar clic en el apartado “Problems Downloading?” (flecha y recuadro azul de 

la imagen del punto 2.3.1.2), lo cual abrirá la siguiente ventana: 

 

Dar clic en cualquiera de las opciones en los recuadros azules y eso debería 

descargar el archivo instalable del paso 2.3.1.2. 

2.3.1.4 En la carpeta destinada a descargas, encontrar el archivo instalable, dar doble 

clic sobre el ejecutable “Avogadro-1.2.0n-win32.exe” (recuadro azul): 
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2.3.1.5 Pedirá permisos para instalar esta aplicación, dar en la opción “Sí” (recuadro 

azul): 

 

2.3.1.6 Se accede al asistente de instalación del programa, dar clic en “Siguiente >”: 

 

Luego, en “Acepto”: 
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Dejar por defecto la opción “Do not add Avogadro to the system PATH” y marcar 

la casilla “Create Avogadro Desktop Icon” (recuadro y palomilla azul) y dar clic en 

“Siguiente >”: 
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Elegir el directorio de destino donde se instalará el programa, por defecto el 

programa se instala en la dirección prestablecida del disco duro principal 

(regularmente C:) “C:\Program Files (x86) \Avogadro”. Si se requiere instalarlo en 

otra dirección escribir la ruta deseada en el recuadro azul y posteriormente dar clic 

en “Siguiente >”: 

 

Deberá elegir una carpeta del menú de inicio por lo que se puede dejar por defecto 

y dar clic en “Instalar”: 
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Empezará el proceso de instalación según las órdenes dadas anteriormente: 
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Una vez terminado el proceso, dar clic en “Terminar” para cerrar el asistente de 

instalación: 

 

En el presente manual se verán funciones básicas del programa, por lo que acceder 

a la siguiente liga proporcionará un conocimiento más amplio del programa: 

https://avogadro.cc/docs/  

2.3.2 Instalación del programa AutoDock Vina (Trott & Olson, 2010) 

2.3.2.1 Acceder a la siguiente liga de internet dando clic en el enlace: 

https://vina.scripps.edu/downloads/  

Lo que conducirá a la siguiente pantalla: 

https://avogadro.cc/docs/
https://vina.scripps.edu/downloads/
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2.3.2.2 A continuación, dar clic en el apartado de “autodock_vina_1_1_2_win32.msi” 

(recuadro rojo de la imagen del punto 2.3.2.1). Automáticamente comenzará la 

descarga del archivo instalable “autodock_vina_1_1_2_win32.msi” (si se trabaja en 

un sistema operativo de 64 bits correrá de la misma manera). Una vez descargado 

se visualiza en su sitio de descargas del explorador utilizado para internet: 

 

2.3.2.3 En la carpeta de descargas, encontrar el archivo instalable, dar doble clic sobre 

el ejecutable “autodock_vina_1_1_2_win32.msi” (recuadro azul): 
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2.3.2.4 Accede al asistente de instalación del programa, dar clic en “Next >”: 

 

Luego dar clic en ”I Agree” (circulo azul) y después en “Next >”: 
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El siguiente paso es muy importante, ya que pide especificar, en “Folder:” (ruta 

coloreada de azul), una ruta de instalación del programa. 

AutoDock Vina se compone por tres archivos, es importante asignar una ruta de 

acceso la cual se recuerde fácilmente. En este ejemplo se conservará la ruta de 

instalación como viene por defecto “C:\Program Files (x86)\The Scripps Research 

Institute\Vina\”, posteriormente, acceder a la misma ruta para visualizar los 

archivos que se instalaron. 

En la otra opción, seleccionar “Everyone” para instalar los archivos en todos los 

usuarios del equipo de cómputo o seleccionar “Just me” para el usuario actualmente 

en uso. 

Recordando la importancia de tener clara la ruta donde se especificará la instalación, 

dar clic en “Next >”: 
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Luego dar clic en “Next >” para comenzar la instalación: 
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Pedirá permisos para instalar esta aplicación, dar clic en la opción “Sí” (recuadro 

negro) 

 

Una vez terminado el proceso saltará la pantalla de término del asistente de 

instalación. Ahora dar clic en “Close” para cerrar el asistente de instalación: 
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2.3.2.5 Siguiendo la ruta de instalación del punto 2.3.2.4 donde quedó instalado 

(C:\Program Files (x86)\The Scripps Research Institute\Vina\), encontrar los tres 

archivos mencionados anteriormente, “vina.exe”, “vina_license.txt” y 

“vina_split.exe”, conviene tener esta carpeta con algún acceso directo o copiar estos 

archivos a otra carpeta que sea de fácil acceso ya que se utilizarán más adelante:  

 

En el presente manual se verán funciones básicas del programa, por lo que acceder 

a la siguiente liga proporcionará un conocimiento más amplio del programa: 

https://vina.scripps.edu/manual/  

2.3.3 Instalación del programa BIOVIA Discovery Studio Visualizer 

2.3.3.1 Acceder a la siguiente liga de internet dando clic en el enlace: 

https://discover.3ds.com/discovery-studio-visualizer-download  

Lo que conducirá a la siguiente pantalla: 

 

El programa pedirá un correo electrónico para descargar el programa (recuadro 

azul), debería utilizar el correo institucional, pero utilizar de otro dominio no afecta 

en el registro, posteriormente, dar clic en “Next” (botón azul). 

https://vina.scripps.edu/manual/
https://discover.3ds.com/discovery-studio-visualizer-download
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2.3.3.2 Después, llenar un formulario con la siguiente información; nombre, apellido, 

compañía (puede ser UAM), país, ciudad y un número de teléfono de 10 dígitos (sólo 

se utiliza como registro). Verificar que se marca la casilla de “I acknowledge and 

agree…” y luego dar clic en Submit (botón azul) 

 

2.3.3.3 Para descargar el cliente, dar clic en “Download” (recuadro y botón azul) 

debajo del texto “DS Visualizer Client (Windows 64 bit)”. 

 

Automáticamente comenzará la descarga del archivo instalable 

“BIOVIA_2021.DS2021Client.exe”, visualizar el archivo descargado en el sitio de 

descargas del explorador utilizado para internet: 
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2.3.3.4 En la carpeta de descargas, encontrar el archivo instalable, dar doble clic sobre 

el ejecutable “BIOVIA_2021.DS2021Client.exe” (recuadro azul): 

 

2.3.3.5 Pedirá permisos para instalar esta aplicación, dar clic en “Sí” (recuadro 

negro): 
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2.3.3.6 Accederá al asistente de instalación del programa, dar clic en “Next >”: 

 

Luego elegir el directorio de destino donde se requiere instalar el programa, por 

defecto el programa se instala en la dirección prestablecida del disco duro principal 

(regularmente C:) “C:\Program Files\BIOVIA\Discovery Studio 2021\”. Si se 

requiere instalar en otra dirección, dar clic en “Change” (recuadro azul) y 

posteriormente dar clic en “Next >”: 
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Luego, dar clic en “Install” y comenzará a instalar el programa con las indicaciones 

antes dadas: 
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Terminado el proceso, aparece la pantalla de terminó del asistente de instalación, 

dar clic en “Finish” para cerrar el asistente de instalación: 

 

2.3.3.7 Para ejecutar el programa, ir al escritorio, ubicar el icono siguiente y dar doble 

clic para ejecutarlo: 
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2.3.3.8 Cuando se ejecuta por primera vez, saldrá una ventana permitiendo elegir las 

opciones correspondientes. Desmarcar la casilla “Import settings from Discovery 

Studio 2019” dejando las otras dos casillas marcadas con palomilla y dar clic en 

“OK”: 

 

Posteriormente, aparece un mensaje advirtiendo que se correrá una prueba para 

determinar el rendimiento de su equipo según su capacidad gráfica, dar clic en “OK” 

para continuar: 

 

Comenzará a correr diversas pruebas y dependiendo del rendimiento de la tarjeta 

gráfica, el equipo de cómputo puede desplegar avisos internos del equipo de 

cómputo, mencionando que la tarjeta gráfica dejó de funcionar; sin embargo, debe 

dejar que termine el proceso, puesto que no afecta el equipo de algún modo. 
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Terminado el procedimiento, preguntará si se desea actualizar la preferencia gráfica, 

dar clic en “OK”: 

 

El programa debería abrir normalmente y se encuentra listo para utilizarse. 
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2.3.4 Instalación del programa MGLTools (AutoDock Tools) 

2.3.4.1 Acceder a la siguiente liga de internet dando clic en el enlace: 

https://ccsb.scripps.edu/mgltools/downloads/ 

Lo que conducirá a la siguiente pantalla: 

 

2.3.4.2 Desplace la ventana hacía abajo hasta encontrar la versión 1.5.7 del instalador 

para el sistema operativo Windows y dar clic en la liga 

“mlgtools_win32_1.5.7_Setup.exe (80Mb)” (recuadro azul): 

 

https://ccsb.scripps.edu/mgltools/downloads/
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2.3.4.3 Automáticamente comenzará la descarga del archivo instalable 

“mlgtools_win32_1.5.7_Setup.exe” y se podrá visualizar en el sitio de descargas del 

explorador utilizado para internet: 

 

2.3.4.4 En la carpeta de descargas, encontrar el archivo instalable, dar doble clic sobre 

el ejecutable “mlgtools_win32_1.5.7_Setup.exe” (recuadro azul): 
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2.3.4.5 Pedirá permisos para instalar esta aplicación, dar clic en la opción “Sí” 

(recuadro negro): 

 

2.3.4.6 Accederá al asistente de instalación del programa, dar clic en “Next >”: 
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A continuación, marcar la opción “I accept the terms of the license agreement” 

(círculo azul) y dar clic en “Yes” para continuar: 

 

Luego elegir el directorio de destino donde se requiere instalar el programa, por 

defecto el programa se instala en la dirección prestablecida del disco duro principal 

(regularmente C:) “C:\Program Files (x86) \MGLTools-1.5.7”. Si se requiere instalar 

en otra dirección, dar clic en “Browse…” (recuadro azul) y posteriormente dar clic 

en “Next >”: 
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Comenzará a instalar el programa con las indicaciones antes dadas: 

 

Una vez terminado el proceso, aparecerá la pantalla de “Commercial Usage” del 

asistente de instalación, dar clic en “OK” para continuar: 
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Una vez concluida la instalación, desactivar las casillas de “Launch PMV” y “Create 

a Quick Launch Shorcut” únicamente dejar marcada la casilla de “Create Desktop 

Shortcut” (palomilla azul)”. Concluido, dar clic en “Finish” para cerrar el asistente 

de instalación del programa: 

 

En el presente manual se verán funciones básicas del programa, por lo que acceder 

a la siguiente liga proporcionará un conocimiento más amplio del programa: 

https://ccsb.scripps.edu/mgltools/documentation/ 

https://ccsb.scripps.edu/mgltools/documentation/
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2.3.5 Instalación del programa PyMOL 

2.3.5.1 Acceder a la siguiente liga de internet dando clic en el enlace: 

https://pymol.org/2/#download; PyMOL es un programa de uso gratuito por 30 

días, para esta práctica es suficiente con utilizar esta versión, para obtenerla, dar clic 

en el icono de sistema de Windows (flecha y recuadro azul), lo que descargará 

automáticamente el instalador del punto 2.3.5.10. Si se desea adquirir una licencia 

de uso educacional, dar clic en “BUY LICENSE” (flecha y recuadro rojo) y seguir con 

los pasos 2.3.5.2 a 2.3.5.9: 

 

2.3.5.2 Lo conducirá a la siguiente pantalla, dar clic en la opción “Student/Teacher” 

(recuadro azul): 

 

https://pymol.org/2/#download
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2.3.5.3 Aparecerá un formulario en el cual se debe registrar ocupación, nombre, 

apellido, correo electrónico (se recomienda que sea el institucional, pero puede ser 

de cualquier dominio), número de teléfono de 10 dígitos (solo se utiliza como 

registro), institución (puede ser UAM) y comentarios opcionales, grado (BS para 

licenciatura), materia, nombre del instructor (puede ser nuevamente UAM) y 

anticipación de grado (se puede dejar en “Unknown”), luego dar clic en “Continue”: 

 

2.3.5.4 Conducirá a los términos del registro, hasta abajo en el recuadro blanco 

introducir los caracteres que aparecen en el recuadro amarillo, por lo que una vez 

que se introduzca, dar clic en “I Agree”: 
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2.3.5.5 Se notificará que un correo con las credenciales correspondientes ha sido 

enviado al correo electrónico proporcionado en el paso 2.3.5.3: 

 

2.3.5.6 En la bandeja de entrada del correo electrónico debería recibir el siguiente 

mensaje del remitente “help@schrodinger.com” (si no se visualiza en la bandeja de 

entrada principal, revisar la carpeta de spam de éste): 

 

2.3.5.7 El correo con las credenciales no debería tardar más de 5 minutos en verse 

reflejado en la bandeja de entrada; sin embargo, si llegará a tardar más tiempo, 

revisar la carpeta de spam, realizar nuevamente el procedimiento o intentar más 

tarde. 

Una vez abierto el correo, observar los datos colocados en el punto 2.3.5.4, deslizar 

el mensaje hasta abajo y encontrar 3 nuevas líneas las cuales dicen “DOWNLOAD 

URL”, “USERNAME” y “PASSWORD” (las credenciales “USERNAME” y 

“PASSWORD”, son personales por lo que son intransferibles), dar clic en 

“DOWNLOAD ULR”: 
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2.3.5.8 Abrirá una nueva pestaña en el navegador que solicitará “Nombre de 

usuario” y “Contraseña”, estos datos son los del correo electrónico “USERNAME” 

y “CONTRASEÑA” respectivamente del punto 2.3.5.7, colocar los datos en las 

entradas correspondientes y dar clic en “Iniciar sesión” (botón azul): 

 

2.3.5.9 Conducirá al sitio de descarga de la licencia y el instalador. Primero, 

descargar la licencia dando clic en “pymol-edu-license.lic” (flecha y recuadro azul): 
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Descargar el archivo “pymol-edu-license.lic”, encontrar el archivo en el sitio de 

descargas del explorador utilizado para internet y la carpeta de descargas. Es 

importante tener localizado este archivo ya que se pedirá más adelante cuando se 

ejecute el programa: 

 

 

Para el instalador, dar clic en “PyMOL Download Page” (flecha y recuadro rojo de 

la imagen del punto 2.3.5.9), dirigirá a la página del punto 2.3.5.1, por lo cual dar clic 

en el símbolo de Windows (flecha y recuadro azul de la imagen del punto 2.3.5.1) 

para que comience la descarga del mismo. 

2.3.5.10 Automáticamente comenzará la descarga del archivo instalable 

“PyMOL-2.5.4-Windows-x86_64.exe” y podrá visualizarlo en su sitio de descargas 

del explorador utilizado para internet: 
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2.3.5.11 En la carpeta de descargas, encontrar el archivo instalable, dar clic 

derecho sobre el ejecutable “PyMOL-2.5.4-Windows-x86_64” (recuadro azul) y 

luego en la opción “Ejecutar como administrador”: 

 

2.3.5.12 Le pedirá permisos para instalar esta aplicación, dar clic en “Sí” 

(recuadro negro): 
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2.3.5.13 Después, acceder al asistente de instalación del programa, dar clic en 

“Next >”: 

 

Aparecerá el aviso de licencia, dar clic en “I Agree”: 
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A continuación, pedirá permisos para instalar el programa en otros usuarios, 

seleecionar la casilla “Just Me (recommended)” y dar clic en “Next>”: 

 

Luego, elegir el directorio de destino donde se requiere instalar el programa, por 

defecto el programa se instala en la dirección preestablecida del disco duro principal 

(regularmente C:) “C:\Users\Miguel\AppData\Local\Schrodinger\PyMOL2”. Si 

se requiere instalar en otra dirección, dar clic en “Browse…” (recuadro azul), y 

posteriormente dar clic en “Next >”: 
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Si no se ejecuta como administrador, es muy probable que se despliegue una ventana 

de error acerca de la instalación ya que requiere menos de 46 caracteres para hacerlo, 

por ello debería dar permisos de administrador del punto 2.3.5.11. Si se desea, dar 

clic en “Cancel” y luego volver al punto 2.3.5.11 para empezar el proceso como 

administrador. 

Posteriormente, seleccionar las casillas “Create start menu shortcuts (supported 

packages only)” y “Clear the package cache upon completion” y dar clic en “Install”: 
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Comenzará a instalar el programa con las indicaciones antes dadas: 

 

Completada la instalación, dar clic en “Next >” 
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Dar clic en “Finish” para cerrar el asistente de instalación del programa: 
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2.3.5.14 Para ejecutar el programa, ir al icono de Windows de la barra de tareas 

(esquina inferior izquierda de la pantalla, comúnmente) o seleccionar la tecla de 

Windows en el teclado, para acceder al siguiente apartado: 

 

En el apartado de “Agregadas recientemente”, si no encuentra el programa 

“PyMOL” dar clic en “Expandir”, buscar el icono y dar clic para ejecutarlo: 

 

Si no se encuentra el icono, buscar en la caja de la barra de tareas “Escribe aquí para 

buscar” (recuadro azul) la palabra “PyMOL”, debería aparecer el programa con el 

mismo icono y dar clic para ejecutarlo: 



 

 

81 
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2.3.5.15 Una vez abierto el programa aparecerá un aviso acerca de la expiración 

de la licencia, dar clic en “OK” y comenzar a trabajar: 

 

2.3.5.16 Para los pasos referentes a la licencia educacional (2.3.5.2 a 2.3.5.9), dar 

clic en “OK” del punto anterior, posteriormente ir a la pestaña “Help” y dar clic en 

“Install new License File” (remarcado azul): 
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2.3.5.17 Dar clic en el apartado “Browse for License File” (recuadro azul) y 

elegir la ruta del archivo que se descargó en el paso 2.3.5.9 el cual tenía por nombre 

“pymol-edu-license.lic”: 

 

2.3.5.18 Al término, observar que se ha activado la licencia y ahora se tendrá 

una fecha de expiración de hasta un año para uso educacional (recuadro negro): 

 

2.4 EJEMPLO 

Se sabe que los AINEs ocasionan efectos secundarios principalmente, al 

interaccionar con COX-1 ¿Cómo podría comprobar, mediante docking molecular, la 

interacción entre flurbiprofeno y COX-1? ¿Qué afinidad presenta el flurbiprofeno 

con respecto al sitio de acción de la COX-1? 

Recomendaciones generales 
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➢ Usar Sistema operativo Windows, ya que el manual se encuentra enfocado en este 

Sistema Operativo y no en MAC o Linux. Puede que los emuladores de Sistema 

Operativo Windows en MAC y Linux no funcionen correctamente al momento de 

llevar a cabo ciertas acciones. 

➢ Seguir los pasos detalladamente ya que se utilizarán signos de puntuación 

específicos y se correrán archivos en el símbolo del sistema, por lo que es importante 

escribir correctamente minúsculas y mayúsculas. Se pueden confundir “.” por “,”; 

“l” por “1”; “I” por “l”, “bd” por “db”, etc., en diversas ocasiones se pegará el texto 

tal como se muestra en el ejemplo para evitar estos errores, sin embargo, cuando se 

trabaje por cuenta propia debe tener en cuenta estos errores comunes. 

➢ Si se tienen diversas rutas de almacenamiento, como tener más de un disco duro o 

guardar archivos generalmente en la “nube”, tener localizados dónde se colocan los 

archivos, ya que su ubicación será importante. 

➢ En caso de que se sigan las rutas de acceso marcadas en el ejemplo, tomar en cuenta 

que “Miguel” deberá aparecer como el usuario que se encuentra trabajando 

actualmente en el equipo de cómputo y “Desktop” puede que se vea reflejado como 

“Escritorio”, por ejemplo: C:\Users\Miguel\Desktop\Docking deberá ser: 

C:\Users\NOMBRE DE USUARIO\ESCRITORIO\Docking 

➢ Si el equipo de cómputo no cuenta con recursos suficientes, ir cerrando ventanas que 

ya no se utilicen para evitar retardos en el proceso. 

➢ Utilizar mouse ya que el touchpad, en laptops, puede no ser preciso para algunas 

acciones que se llevarán a cabo.  

Para poder llevar a cabo el docking molecular del Flurbiprofeno con la COX y poder 

observar su afinidad con el sitio activo de ésta, proceder de la siguiente manera: 

2.4.1 Crear carpetas de fácil acceso para los archivos posteriores 

2.4.1.1 Crear una carpeta de fácil acceso en el escritorio del equipo de cómputo 

llamada Docking (colocar el puntero en cualquier parte en blanco de su escritorio > 

clic derecho > Nuevo > Carpeta) por lo que la ruta de acceso a ésta será 

“C:\Users\Miguel\Desktop\Docking”: 
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2.4.1.2 Dentro de la carpeta Docking, crear otra llamada Vina, por lo que la ruta de 

acceso a ésta será “C:\Users\Miguel\Desktop\Docking\Vina”: 

 

2.4.2 Buscar la proteína de interés en RCSB PDB 

2.4.2.1 Existen diversas páginas para buscar datos para utilizar en docking 

molecular, en el presente ejemplo se utiliza la página de “Research Collaboratory for 

Structural Bioinformatics” por sus siglas RCSB PDB en la siguiente liga: 

https://www.rcsb.org/. 

2.4.2.2 Una vez dentro de la página, buscar la proteína de interés en la barra blanca 

de búsqueda. Se puede buscar por términos, ID(s) o secuencia. 

 

https://www.rcsb.org/
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2.4.2.3 Buscar la proteína con ID 3N8Z, seleccionar la única opción mostrada que 

debería ser la proteína buscada (Crystal Structure of Cyclooxygenase-1 in Complex 

with Flurbiprofen). Se muestran diversos apartados; los más destacados para un 

mejor rendimiento en el docking molecular son: 

2.4.2.3.1 Organismo (preferente que sea para organismos Homo sapiens) 

2.4.2.3.2 Mutaciones (No) 

2.4.2.3.3 Método de cristalización (difracción de rayos X) 

2.4.2.3.4 Resolución (preferente que sea menor a 3.0 Å) 

2.4.2.3.5 Descargar archivos (de aquí se descargarán los archivos buscados) 

 

Bajando más por la página, se llega al apartado de “Ligandos” y sus interacciones 

que posee la molécula con la proteína. 
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2.4.2.4 Identificados los puntos de interés, dar clic en “Download Files” (punto 

2.4.2.3.5) y proceder a descargar el archivo “PDB Format” (no confundir con “PDB 

Format (gz)”, lo que descargará el archivo 3n8z.pdb: 

 

2.4.2.5 Descargado el archivo 3n8z.pdb, localizar el archivo en la carpeta de 

“Descargas” y copiar este archivo a la carpeta Docking del punto 2.4.1.1: 

Nota: Puede ser que el archivo únicamente lleve por nombre 3n8z sin la extensión 

“.pdb”, para corroborar que el archivo corresponde a la extensión, dar clic derecho 

sobre el mismo>propiedades>Tipo de archivo>(.pdb) que indica la extensión del 

archivo. 
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2.4.3 Buscar un ligando en PubChem 

2.4.3.1 Para buscar el ligando o molécula de interés, existen diversas páginas para 

ello o inclusive programas como Avogadro, ChemBioOffice, entre otros, permiten 

realizar estructuras moleculares con libertad y éstas pueden ser utilizadas para el 

docking molecular, pero en este ejemplo se utiliza la página “PubChem National 

Center for Biotechnology Information (NCBI), National Library of Medicine (NLM), 

National Institutes of Health (NIH)” en la siguiente liga: 

https://pubchem.ncbi.nlm.nih.gov/  

Una vez dentro de la página, buscar el ligando o molécula de interés en la caja de 

búsqueda. Aquí se pueden buscar por términos, CAS, principio activo, entre otros: 

 

https://pubchem.ncbi.nlm.nih.gov/
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2.4.3.2 Buscar la molécula “Flurbiprofeno”, seleccionar la primera opción dada en el 

apartado de “Compound”. Dirigirá a la página del compuesto, dar clic en la primera 

opción que aparece en el apartado “BEST MATCH”: 

 

2.4.3.3 Una vez determinada la estructura desaseada, dar clic en “Download”, dar 

clic en el apartado “Save” de “SDF” en “3D Conformer” (recuadro negro) para 

descargar una estructura en 3D: 

Nota: También se pueden descargar y utilizar estructuras en 2D ya que el programa 

Avogadro, realiza arreglos para que la molécula en 2D pase a ser 3D. 
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2.4.3.4 Descargará un archivo con nombre “Conformer3D_CID_3394”, ubicar el 

archivo en la carpeta de “Descargas” y copiar el archivo a la carpeta Docking del 

punto 2.4.1.1: 

 

2.4.4 Modificar un ligando en Avogadro 

2.4.4.1 Abrir el programa Avogadro instalado en el punto 2.3.1, dar clic en el icono 

correspondiente encontrado en el escritorio: 

 

2.4.4.2 Una vez abierto el programa, abrir el ligando en la ubicación donde se guardó 

(en el caso del ejemplo, seguir la ruta del directorio de la carpeta de Docking del 

punto 2.4.1.1), dar clic en File>Open> 

C:\Users\Miguel\Desktop\Docking\Conformer3D_CID_3394\Abrir: 

Nota: Para encontrar la carpeta donde se encuentra el archivo en cuestión, navegar 

por el panel ubicado a la izquierda de la ventana, si la carpeta se encuentra en el 

escritorio, en el panel izquierdo, dar clic en Escritorio>Docking, debería visualizarse 

el archivo como en la siguiente imagen: 
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2.4.4.3 Si se descargó la figura en 3D, se visualizará en la ventana del programa, si se 

descargó en 2D, el programa realizará los arreglos correspondientes para su 

conversión a 3D. 

Se mostrará la molécula en la ventana principal. Se manipula manteniendo apretado 

clic izquierdo para que roté sobre su propio eje, con el clic derecho se mueve de lugar 

en los ejes X, Y, y con la rueda del ratón se aleja o acerca la molécula. 
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2.4.4.4 Para seguir optimizando la molécula, dar clic en Build>Add Hydrogens for 

pH… Dirigirá a una ventana para elegir a qué nivel de pH se requiere agregar o 

remover los hidrógenos presentes, asignar pH 7.4 y dar clic en “OK”: 
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2.4.4.5 Posteriormente, dar clic en Auto Optimization Tool (letra E con una flecha 

verde debajo enmarcada en un recuadro azul en la imagen), abrirá un panel a la 

izquierda, dar clic en las casillas “Fixed atom are movable” y “Ignored atoms are 

movable”, dar clic en “Start” (dejar los demás datos sin modificar, hablando de UFF 

y “Steps per Update:” 4): 
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2.4.4.6 Comenzará por hacer arreglos de energía, esperar hasta que el valor de dE 

(subrayado azul) sea igual a 0: 

 

2.4.4.7 Para terminar y guardar la molécula optimizada, dar clic en a File>Save As… 

Ubicar la carpeta de Docking del punto 2.4.1.1 y guardar la molécula con el nombre:  

FLP_opt.pdb 

Asegurar que en el apartado “Tipo” se encuentre seleccionada la extensión “PDB 

(*.pdb)” y dar clic en “Guardar”. 

Nota: Considerar mayúsculas y signos de puntuación. Aunque el apartado “Tipo” 

esté seleccionado para la extensión “PDB (*.pdb)” es necesario poner en el nombre 

la terminación .pdb 
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Cerrar el programa si el equipo de cómputo no cuenta con suficientes recursos. 

2.4.5 Modificar una proteína en PyMOL 

2.4.5.1 Ejecutar el programa PyMOL según los puntos 2.3.5.14 a 2.3.5.15. Dar clic en 

File>Open> C:\Users\Miguel\Desktop\Docking\3n8z\Abrir (en el caso del 

ejemplo, se sigue la ruta del directorio de la carpeta de Docking del punto 2.4.1.1) 

 

Abrirá la molécula descargada en los puntos 2.4.2.4 a 2.4.2.5, y se visualizará en el 

programa.  
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2.4.5.2 Al igual que en el punto 2.4.4.3, manteniendo el clic izquierdo puede girar la 

proteína sobre su propio eje, manteniendo el clic derecho acercará o alejará la 

proteína se realizan movimientos hacia arriba o abajo con el mouse, 

respectivamente. 

2.4.5.3 La proteína descargada en el punto 2.4.2.4, se descarga con moléculas de agua 

cristalizada, las cuales serán eliminadas de la proteína para evitar interacciones 

indeseadas. Para esto, en el cuadrante superior derecho de la pantalla. localizar “all” 

y “3n8z” (flecha morada). 

Dar clic en la letra “A” (flecha y fondo morado) del apartado “all”, lo cual desplegará 

un menú de “Acción”: 

 

Dar clic en “remove water” (letras rojas, fondo blanco) del menú antes desplegado 

para eliminar el agua cristalizada de toda la proteína: 
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Notar que los puntos rojos alrededor de la molécula desaparecen. 

2.4.5.4 La proteína se compone por 2 subunidades A y B, en este ejemplo se trabaja 

con la cadena A, eliminando la cadena B, y se remueven los ligandos añadidos que 

tampoco son de interés. 

Para remover la cadena B, escribir en la barra de comando (flecha roja) la siguiente 

orden y luego oprimir la tecla “Enter” del teclado: 

remove chain B 

(Distinguir que hay espacios y la letra B es mayúscula) 

Notar que la proteína se reduce de tamaño ya que se removió la mitad de su 

estructura. 
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2.4.5.5 Para remover los ligandos añadidos, es necesario ver la secuencia de la 

proteína, dar clic en la letra S (flecha azul) o dar clic en Display>Sequence. 

Desplegará una nueva barra de desplazamiento a través de la secuencia (flecha 

verde), mostrará el nombre del archivo cargado o el nombre de la proteína dada 

(flecha blanca), la cadena inicial de la secuencia (flecha naranja) y el número o 

posición del aminoácido en la secuencia (flecha amarilla). 
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2.4.5.6 Desplazar a través de la barra deslizable (flecha verde de la imagen del punto 

2.4.5.5) hasta encontrar el final de la cadena de aminoácidos, ubicar el aminoácido 

final atribuible a la proteína (flecha azul) y seguido, identificar los residuos que no 

son atribuibles a la proteína, es decir, los ligandos y residuos que se encontraban 

cristalizados con la misma (recuadro rojo): 

 

2.4.5.7 Para eliminar solo el residuo “HEM”, dar clic en las letras verdes “HEM” y 

observar en el cuadrante derecho el apartado (sele), dar clic en la letra “A” de (sele) 

para que desplace el menú de acción, dar clic en la opción “remove atoms” (letras 

rojas, fondo blanco), observar que la molécula “HEM” se elimina de la proteína y el 

apartado (sele) desaparece: 
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Nota: En el punto 2.4.5.8 se eliminan los residuos “BOG”, “NAG”, “NDG”, “BMA” 

y “MAN”, sin embargo, se debe tener cuidado de no eliminar el residuo “FLP” ya 

que será ocupado posteriormente. 

2.4.5.8 Para seleccionar los residuos “BOG”, “NAG”, “NDG”, “BMA” y “MAN”, 

dejar apretado el clic izquierdo sobre “BOG” y deslizar el puntero del mouse a la 

derecha para seleccionar las unidades a la derecha. Observar, como en el punto 

2.4.5.7, que resaltan las moléculas seleccionadas y aparece el apartado de (sele). Para 

remover las moléculas, dar clic en “A” de (sele) y luego “remove atoms” para 

eliminar los residuos seleccionados: 

 

2.4.5.9 Se tendrá como resultado la proteína con el ligando “FLP”. Dar clic en 

File>Export Molecule. 

Aparecerá una ventana, dar clic en el apartado “Selection”, desplazar la lista hasta 

encontrar la opción “all”. El apartado State se quedará tal cual como está, marcar la 

casilla de “Original atom order (according to “rank”)”. Dar clic en “Save…” lo que 

conducirá a guardar la proteína con el ligando FLP acoplado: 



 

 

101 

 

 

 

2.4.5.10 Guardar la molécula en la dirección de la carpeta Docking del paso 

2.4.1.1 con el nombre: 

3n8z_SA.pdb 

Asegurar que en el apartado “Tipo” se encuentre seleccionada la opción “PDB 

(*.pdb)”, no confundir con “PDBx/mmCIF”, y dar clic en “Guardar”. 

Nota: Considerar mayúsculas y signos de puntuación. Aunque el apartado “Tipo” 

esté seleccionado para la extensión “PDB (*.pdb)” es necesario poner en el nombre 

la terminación .pdb 
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2.4.5.11 Repetir los pasos del punto 2.4.5.7 para seleccionar y eliminar el 

ligando “FLP” de la proteína. Guardar la molécula sola como los pasos 2.4.5.9 y 

2.4.5.10 con el siguiente nombre: 

3n8z_clean.pdb 

 

Cerrar el programa si el equipo de cómputo no cuenta con suficientes recursos. 
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2.4.6 Optimización del ligando en AutoDock Tools 

2.4.6.1 Abrir el programa AutoDockTools-1.5.7 instalado en el punto 2.3.4, dar clic 

en su icono correspondiente encontrado en el escritorio: 

 

2.4.6.2 Una vez que el programa se encuentre abierto, dar clic en 

Ligand>Input>Open… 

 

2.4.6.3 Aparecerá una ventana para buscar el archivo. Del lado izquierdo de la 

ventana se navega entre diversos paneles, dar clic en “Escritorio” y luego en la 

carpeta “Docking”. 

Abrir el archivo FLP_opt.pdb guardado en los puntos 2.4.3.3 a 2.4.3.4. Seleccionar en 

“Tipo de archivo” “PDB Files (.pdb)” ya que por default el programa estará 

buscando archivos con terminación (.pdbqt), luego dar clic en “Abrir”: 
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2.4.6.4 Aparecerá una ventana informando acerca de las torciones encontradas en la 

molécula y demás datos, dar clic en “Aceptar”: 
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2.4.6.5 La molécula podrá ser manipulada al igual que en el punto 2.4.4.3. Para 

añadir “cargas parciales”, dar clic en Edit>Charges>Compute Gasteiger 

 

2.4.6.6 La molécula ahora contará con “cargas parciales”, lo que ayudará a un mejor 

rendimiento al momento de realizar el docking molecular, y aparecerá el siguiente 

mensaje dando un valor a esas cargas, dar clic en “Aceptar”: 
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2.4.6.7 Para guardar la molécula con las especificaciones antes descritas, dar clic en 

Ligand>Output>Save as PDBQT… 

 

Guardar la nueva molécula en la carpeta Vina del punto 2.4.1.2, asignando el 

nombre: 

FLP_opt.pdbqt 

Asegurar poner al final la extensión “.pdbqt”, probablemente el archivo no contenga 

esta extensión; en consecuencia, el archivo no funcionará más adelante, dar clic en 

“Guardar”. 

Nota: Observar que el archivo se guardó en la carpeta Vina y no en Docking y su 

extensión ahora es .pdbqt en lugar de .pdb, como en anteriores ocasiones. 
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2.4.6.8 Terminado el proceso de optimización de la molécula, dar clic izquierdo sobre 

la molécula “FLP_opt” en el panel izquierdo del programa, lo que hará que resalte 

en amarillo, dar clic derecho sobre la misma para desplegar diversas opciones, dar 

clic en “Delete” y observar que la molécula desaparece: 
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2.4.7 Optimización de la proteína en AutoDock Tools 

2.4.7.1 Asegurar haber eliminado el ligando en el paso 2.4.6.8. Dar clic en 

Grid>Macromolecule>Open… 

 

2.4.7.2 Aparecerá una ventana para buscar el archivo. Del lado izquierdo de la 

ventana se puede navegar entre diversos paneles, dar clic en “Escritorio” y luego en 

la carpeta “Docking”. 

Abrir el archivo 3n8z_clean.pdb (el que no contiene ligando FLP) guardado en el 

punto 2.4.5.11. Seleccionar en “Tipo de archivo” “all files (*.*)” ya que por default el 

programa estará buscando archivos con terminación (.pdbqt), dar clic en “Abrir”: 



 

 

109 

 

 

 

2.4.7.3 La proteína se abrirá y tendrá un color rosa. Aparecerá una ventana con 

detalles acerca de la molécula (aunque mencione “WARNING” no significa algún 

tipo de problema, el programa tiene por default ese título para esa pantalla de aviso), 

dar clic en “Aceptar”: 

 

2.4.7.4 Se abrirá nuevamente una ventana solicitando guardar la proteína. Ir a la 

ubicación de la carpeta de Vina, realizada en el punto 2.4.1.2, y guardar el archivo 

con el nombre: 

3n8z_clean.pdbqt 

Asegurar poner al final la extensión “.pdbqt” ya que puede que el archivo no tenga 

dicha extensión y, por lo tanto, no funcione más adelante, dar clic en “Guardar”: 

Nota: Observar que el archivo se guardó en la carpeta Vina y no en Docking y su 

extensión ahora es .pdbqt en lugar de .pdb, como en anteriores ocasiones. 
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2.4.7.5 La proteína tomará una coloración gris. Dar clic en Edit>Charges>Compute 

Gasteiger, para agregar “cargas parciales” al igual que se realizó con el ligando en 

el punto 2.4.6.5. 

 



 

 

111 

 

 

2.4.7.6 La proteína ahora contará con “cargas parciales”, lo que ayudará a un mejor 

rendimiento al realizar el docking molecular, y aparecerá el siguiente mensaje dando 

un valor a esas cargas, dar clic en “Aceptar”: 

 

2.4.7.7 Para guardar la molécula, dar clic en File>Save>Write PDBQT 
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2.4.7.8 Aparecerá una ventana, dar clic en “BROWSE”: 

 

2.4.7.9 Guardar la proteína en la carpeta Vina, reescribir el archivo creado en el paso 

2.4.7.4 dejando como nombre: 

3n8z_clean.pdbqt 

Asegurar poner al final la extensión “.pdbqt” ya que puede que el archivo no tenga 

esta extensión y, por lo tanto, no funcione más adelante, dar clic en “Guardar”. 

Saltará una advertencia acerca de reemplazar el archivo , dar clic en “Sí”: 

 

La ventana del paso 2.4.7.8 volverá a surgir, dar clic en “OK” 

2.4.7.10 Para este paso es necesario que se haga una investigación bibliográfica 

del mecanismo de acción de la molécula en cuestión y tener presentes los 

aminoácidos con los que interacciona, ya que se preparará visualmente la zona 

donde se pueda crear el Grid (la zona donde se realizará el docking molecular).  

Dar clic en el signo de “+” encontrado al lado izquierdo del nombre de la proteína 

“3n8z_clean”. Aparecerá una “A” indicando la cadena de la proteína, si no se 

removió la cadena “B” en el punto 2.4.5.4, elegir únicamente la cadena “A” para 

trabajar ya que igualmente aparecerá el apartado de la cadena B. 
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Dar clic en el signo “+” de la cadena “A” y visualizar los aminoácidos 

correspondientes de la secuencia: 
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2.4.7.11 Los aminoácidos en donde interactúa la molécula para este ejemplo 

son: LEU 352 SER 530 VAL 349 ALA 527 LEU 531 ARG 120 TYR 355 VAL 116 LEU 

359. Una vez ubicados en la lista desplegada anteriormente, usando la barra de 

deslizamiento, seleccionar el ovalo de “C” de cada aminoácido, cambiará de color 

blanco a rojo (flecha azul), mientras que en la proteína se podrá observar cómo se 

colocan esferas envolviendo el aminoácido seleccionado (flecha verde). 
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2.4.7.12 Para preparar el Grid, el cual determina la zona en la que se realizará 

el docking molecular, dar clic en Grid>Grid Box… 

 

Aparecerá una ventana de opciones y un cubo de color rojo, verde y azul indicando 

los ejes X, Y, Z respectivamente del espacio en la proteína: 
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2.4.7.13 Para centrar el Grid en la zona resaltada con esferas del punto 2.4.7.11, 

mover las “perillas” debajo del texto “<offset>” o poner el valor deseado en los textos 

x center, y center, z center (cuadro rojo). 

Para modificar las dimensiones del Grid, mover las “perillas” del cuadro azul o dar 

clic derecho a las mismas lo que abrirá otra ventana (flecha azul), mover el intervalo 

de “Value” al valor deseado seguido de “OK”. 

El valor de “Spacing (angstrom)” por defecto viene en 0.375 por lo que será el valor 

utilizado. 

Para este ejemplo, se cubrirá toda la zona con el Grid conforme los siguientes 

valores: 

x-dimension: 52 

y-dimension: 46 

z-dimension: 52 

Spacing (angstrom): 0.375 

x center: -17.786 

y center: 48.786 

z center: 8.189 
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2.4.7.14 Terminado el proceso para centrar el Grid, dar clic en File>Close saving 

current, el Grid desaparecerá y la ventana se cerrará. La configuración de las 

dimensiones y espacio configurado se habrán guardado con las especificaciones 

dadas. 
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2.4.7.15 Para generar un mapa dentro del Grid, lo cual sirve para identificar los 

átomos del ligando (Flurbiprofeno) y pueda tener un mejor rendimiento a la hora de 

realizar el docking molecular, dar clic en Grid>Set Map Types>Open Ligand… Abrir 

el archivo creado en el punto 2.4.6.7 FLP_opt.pdbqt ubicado en la carpeta Vina del 

punto 2.4.1.2: 

 

Observar que el ligando aparece en un lugar alejado de la proteína. 
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2.4.7.16 Para terminar y guardar las configuraciones dadas al Grid, dar clic en 

Grid Output>Save GPF… 

 

Pedirá elegir una ruta de guardado, elegir la carpeta Docking del punto 2.4.1.1, 

colocar el siguiente nombre y luego dar clic en “Guardar”: 

grid.gpf 

Observar que se guardó en la carpeta Doking y no Vina. 
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2.4.7.17 El archivo podrá ejecutarse con la aplicación Bloc de notas o Wordpad 

instaladas por defecto en el equipo de cómputo. En la ventana se mostrará la 

configuración del Grid, anteriormente programada, entre otra información acerca 

del ligando seleccionado y los mapas creados. No es necesario abrir o editar nada de 

su contenido, únicamente corrobora lo programado, anteriormente, en la proteína. 

 

Cerrar el programa si el equipo de cómputo no cuenta con suficientes recursos. 
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2.4.8 Ejecutar docking molecular con AutoDock Vina 

2.4.8.1 Abrir la carpeta Vina del punto 2.4.1.2 y dentro de la misma carpeta generar 

un archivo de texto, dar clic derecho en cualquier parte en blanco dentro de la 

carpeta>Nuevo>Documento de texto: 

 

2.4.8.2 Cambiar el nombre del nuevo archivo creado, dar clic derecho sobre el mismo 

y dar clic en “Cambiar nombre” asignando el nombre: 

config 

2.4.8.3 Abrir el archivo creado en el punto 2.4.8.2, ya sea con el programa Bloc de 

notas o WordPad instalados por defecto en el equipo de cómputo, escribir las 

siguientes líneas de comando: 

receptor = 3n8z_clean.pdbqt 

ligand = FLP_opt.pdbqt 

 

center_x = -17.786 

center_y = 48.786 
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center_z = 8.189 

 

size_x = 19.5 

size_y = 17.25 

size_z = 19.5 

 

exhaustiveness = 500 

 

Importante tener en cuenta lo siguiente: 

a) Utilizar mayúsculas y minúsculas como se muestran en el ejemplo, si las moléculas 

poseen otro nombre al propuesto durante el ejemplo, escribir los nombres 

exactamente igual a como están guardadas. 

b) Asegurar poner “espacios” antes y después de los signos de = (igual). 

Dar espacios en blanco, por ejemplo, al momento de escribir el comando: ligand = 

FLP_opt.pdbqt[en este momento, oprimir en el teclado “Enter” para que se haga un 

espacio para abajo, y nuevamente, oprimir en el teclado “Enter” para crear un 

espacio en blanco] ahora escribir la siguiente línea la cual será center_x = -17.786… 

c) El nombre puesto en “receptor” será el nombre del archivo asignado a la proteína 

realizada en el punto 2.4.7.9, “ligand” el nombre del archivo asignado a la molécula 

realizada en el punto 2.4.6.7, los valores de “center” serán las coordenadas y “size” 

las dimensiones dadas al Grid en el punto 2.4.7.13, observar que los valores de “size” 
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no corresponden a 52 46 52, ya que estos valores se multiplican por el valor de 

“spacing” (0.375) y el resultado es el colocado en “size” (si no se recuerdan estos 

valores, pueden ser corroborados con el archivo grid.gfp creado en el punto 2.4.7.16, 

abrir este archivo con Bloc de notas o WordPad). Por último “exhaustiveness” es un 

valor que pide AutoDock Vina y será de 500. 

2.4.8.4 Corroborado lo anterior, dar clic en Archivo>Guardar. Cerrar esta ventana ya 

que no será necesaria de nuevo, a menos que se requiera editar algún comando. 

2.4.8.5 Abrir la carpeta de la ruta del punto 2.3.2.4, la cual contiene los archivos 

instalados del programa vina, recordar que en ésta carpeta se encuentran tres 

archivos (vina.exe o vina, vina_license y vina_split.exe o vina_split), copiar 

únicamente el archivo por nombre vina (o vina.exe, si el equipo de cómputo permite 

ver extensiones en el nombre), pegar en la carpeta Vina del punto 2.4.1.2 quedando 

cuatro archivos en la carpeta Vina, los cuales incluyen: el ligando FLP_opt.pdbqt, la 

proteína 3n8z_clean.pdbqt, el archivo config, y ahora el ejecutable vina: 

 

2.4.8.6 En la barra de tareas, esquina inferior izquierda, observar una caja de 

búsqueda en blanco, escribir en este apartado: 

Ejecutar 

Dar clic en la opción que menciona la aplicación del mismo nombre: 
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2.4.8.7 Se abrirá una pequeña ventana que lleva por título “Ejecutar”, escribir en la 

caja en blanco encontrada después de “Abrir:”: 

cmd 

 

Dar clic en “Aceptar”. 
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2.4.8.8 A partir de este punto, se abrirá una ventana perteneciente al símbolo del 

sistema por lo que es importante seguir los pasos como se indican, tener localizados 

los archivos y sus ubicaciones dentro de las rutas específicas, si se tienen problemas 

siguiendo los pasos, cerrar la ventana y volverlo a intentar o buscar asesoría. 

2.4.8.9 Una ventana en negro se ejecutará esperando que se introduzcan líneas de 

comando para continuar. Por defecto, se ubica en la ruta C:\Usuario\Nombre del 

usuario. El objetivo es llegar a la carpeta Vina a través de comandos, introducir: 

cd Desktop 

Oprimir la tecla “Enter” del teclado. 

Nota: Observar los espacios, mayúsculas, signos de puntuación que se utilizarán ya 

que, si existe un error, no se podrá acceder a las rutas deseadas. Si al momento de 

introducir los comandos o se tienen carpetas de nombre similar y se cometió un error 

al momento de escribir, volver un paso atrás escribiendo el comando: cd.. 

 

2.4.8.10 Observar que en la línea de comando se agregó “Desktop” a la ruta 

especificada. Seguir los pasos del punto 2.4.8.9, escribir: 

cd Docking 

Oprimir la tecla “Enter” del teclado. 
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2.4.8.11 Observar que en la línea de comando se agregó “Docking” a la ruta 

especificada. Seguir los pasos del punto 2.4.8.10, escribir: 

cd Vina 

Oprimir la tecla “Enter” del teclado. 
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2.4.8.12 Observar que en la línea de comando se agregó “Vina” a la ruta 

especificada. Llegado a la ruta del objetivo, la carpeta Vina, escribir en una sola línea 

de comando lo siguiente: 

vina.exe --config config.txt --log log.txt --out 3n8z_dock.pdbqt 

Oprimir la tecla “Enter” del teclado, se ejecutará el docking molecular en AutoDock 

Vina: 

Nota: Observar los espacios incluidos (vina.exe[espacio]--config…), se utilizan 2 

guiones en lugar de 1 (--config, no -config) y colocar las extensiones pertinentes en 

sus lugares correspondientes (vina.exe, config.txt, log.txt, 3n8z_dock.pdbqt). 
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2.4.8.13 El proceso del docking molecular comenzará normalmente y aparecerá 

la siguiente pantalla indicando, entre otras cosas, el porcentaje del proceso: 

 

Para este punto, el equipo de cómputo se verá ralentizado, dependiendo de los 

recursos de éste, si no se necesita el equipo para otras actividades, dejar correr 

únicamente el proceso de docking molecular y esperar que concluya. 
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2.4.8.14 Concluido el proceso, la barra de porcentaje se llenará al 100% y se 

mostrará información acerca de las conformaciones resultantes (mode), la afinidad 

(affinity (kcal/mol)) y la distancia relativa a la mejor conformación (dist from best 

mode). Estos datos pueden ser consultados en el archivo log.txt que se creó en la 

carpeta Vina. Para cerrar la ventana, escribir en la línea de comando: exit y oprimir 

“Enter” en el teclado o dar clic en la X de la esquina superior derecha de la ventana. 
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2.4.9 Analizar resultados en AutoDock Tools 

2.4.9.1 Realizado el docking molecular en AutoDock Vina, analizar los resultados del 

punto 2.4.8.14 en AutoDock Tools, abrir el programa como en el punto 2.4.6.1 y dar 

clic en Analyze>Dockings>Open AutoDock vina result… 
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2.4.9.2 Abrir el archivo creado durante el docking molecular, debe estar en la carpeta 

Vina llamado 3n8z_dock.pdbqt, como se nombró en el punto 2.4.8.12: 

 

2.4.9.3 Aparecerá una ventana preguntando cómo se desea cargar la molécula, 

seleccionar la opción “Single molecule with multiple conformations” y dar clic en 

“OK”: 
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2.4.9.4 El programa avisará cuantas conformaciones (poses) se encontraron dentro 

del archivo, las cuales corresponden a las conformaciones mostradas en el punto 

2.4.8.14: 

 

2.4.9.5 Por defecto, se mostrará la conformación con energía más negativa, que 

corresponde a la primera conformación mostrada en el punto 2.4.8.14 (-8.5). Para 

visualizar las conformaciones restantes, oprimir las “flechas” del teclado para ir 

cambiando de estructura. 

Si no se visualiza el número como en la imagen, rotar la molécula, dejar apretado el 

clic izquierdo del mouse y mover la molécula hasta su correcta visualización: 
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2.4.9.6 Para guardar la conformación que tuvo el valor mayormente negativo (-8.5), 

dar clic en File>Save>Write PDB 

 

Aparecerá otra ventana, dar clic en “BROWSE” y buscar la carpeta Vina para guardar 

el archivo con el siguiente nombre: 

FLP_MC.pdb 

Colocar la extensión .pdb en el nombre y dar clic en “Guardar”, posteriormente el 

programa regresará a la ventana anterior, dar clic en “OK” para terminar. 
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El programa regresará a la ventana del punto 2.4.9.5, si el equipo de cómputo no 

cuenta con recursos suficientes , cerrar AutoDock Tools. 

2.4.9.7 Abrir PyMOL como en los puntos 2.3.5.14 a 2.3.5.15 y dar clic en File>Open 

 

Abrir el archivo creado en el punto 2.4.9.6 con nombre FLP_MC.pdb de la carpeta 

Vina, dar clic en “Abrir”: 
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2.4.9.8 Se proyectará el ligando guardado. Posteriormente, abrir la proteína 

guardada en el punto 2.4.5.11 con nombre 3n8z_clean.pdb encontrada en la carpeta 

Docking, dar clic en File>Open>3n8z_clean.pdb: 

 

Observar que el archivo 3n8z_clean.pdb se encuentra en la carpeta Docking y no Vina, 

el que se encuentra en la carpeta Vina lleva por nombre 3n8z_clean.pdbqt, que cambia 

la terminación del archivo. 

Observar que tanto el ligando como la proteína se encuentran en el mismo archivo: 
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2.4.9.9 Para proceder a juntar ambas moléculas y se tenga un solo archivo como en 

el punto 2.4.5.9, dar clic en File>Export Molecule… 

 

Aparecerá la siguiente ventana, en “Selection” buscar y seleccionar “all”, marcar la 

casilla “Original atom order (according to “rank”)” y dar clic en “Save…”: 
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Guardar este complejo en la carpeta Vina con el siguiente nombre y después dar clic 

en “Guardar”: 

3n8z-FLP-complejo_vina.pdb 

Tener activado en el apartado “Tipo” la opción “PDB” no confundir con “PDBx”. 
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2.4.9.10 Guardado el complejo, comparar con el descargado y preparado del 

punto 2.4.5.10. Dar clic en File>Reinitialize>Everithing, para reiniciar el programa: 

 

2.4.9.11 Abrir el archivo guardado en el punto 2.4.9.9, el cual es el complejo 

resultado del docking molecular, encontrado en la carpeta Vina y lleva por nombre 

3n8z-FLP-complejo_vina.pdb: 

 

Observar en el panel de la derecha, no aparecen 2 archivos separados, solo aparecen 

los apartados “all” y “3n8z-FLP-complejo_vina”, y la molécula ahora se ilumina de 

color verde. 
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2.4.9.12 Para comparar la molécula del punto 2.4.9.9 con la del punto 2.4.5.10 

encontrada en la carpeta Docking que lleva por nombre 3n8z_SA.pdb, dar clic en 

File>Open>Docking>3n8z_SA.pdb: 

 

Observar que la proteína no cambió de lugar ni color, únicamente apareció otra 

molécula (color cian) en el lugar donde se encontraba la inicial (color verde), al igual 

que su nombre en el apartado de la derecha: 
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2.4.9.13 Para tener una mejor visualización de ambas moléculas y la interacción 

con los residuos, dar clic en “A” de “all”>preset>ligand sites>cartoon: 

 

Se tendrá una mejor vista de la interacción entre ambos. Comparar (visualmente) la 

conformación entre el resultado del docking molecular (punto 2.4.9.9) contra el 

resultado de la cristalización (punto 2.4.5.10), observar que son muy similares y casi 

sobrepuestas: 
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2.4.10 Presentación de resultados en 2D y 3D 

2.4.10.1 Repetir los pasos del punto 2.4.9.10 para reiniciar el programa, abrir la 

molécula 3n8z-FLP-complejo_vina.pdb de la carpeta Vina. 

Seguir los pasos del punto 2.4.9.13 para tener una vista mejor de la interacción entre 

la molécula y la proteína, dar clic en “A” de “all”>preset>ligand sites>cartoon. 

2.4.10.2 Para nombrar a los residuos de aminoácidos que hacen interacción con 

la molécula de interés, dar clic en el residuo en cuestión, aparecerá el apartado (sele): 

 

Dar clic derecho en cualquier cuadrado rojo que implica el aminoácido, desplegará 

unas opciones con respecto a éste, dar clic en label>residues, lo que mostrará las 

iniciales y el número del residuo correspondiente: 
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Para dejar de seleccionar ese residuo y poder elegir otro, dar clic en “A” de “(sele)” 

y “delete selection” (letras rojas), dejará el nombre del aminoácido, pero 

desaparecerá la selección de éste: 
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2.4.10.3 Para guardar lo proyectado en la pantalla actual como imagen en 3D, 

dar clic en el apartado “Draw/Ray” ubicado en la esquina superior derecha (flecha 

azul): 

 

Aparecerá una ventana que permite modificar las dimensiones de la imagen. 

Después de editarla a preferencia, dar clic en “Ray (slow)” (recuadro azul): 

 

Aparecerá nuevamente una ventana, observar que el fondo negro se vuelve 

“cuadros”, esto es para que en la imagen no salga el fondo negro, dar clic en “Save 

Image to File”: 
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Guardar la imagen en la carpeta Vina con el nombre: 

3n8z-FLP-3D 

Quedará la imagen guardada de la siguiente manera: 

 

2.4.10.4 Si por cuestión de licencia el programa menciona no poder utilizar la 

función de “Ray”, dar clic en File>Export Image As…>PNG…>Save PNG image 

as…>Elegir el directorio del punto 2.4.10.3. 

Cerrar el programa PyMOL. 
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2.4.10.5 Para crear la imagen en 2D, abrir el programa Discovery Studio 2021 

Client de acuerdo con los puntos 2.3.3.7 a 2.3.3.8. Una vez dentro del programa, dar 

clic en File>Open… 

 

Buscar el archivo con nombre 3n8z-FLP-complejo_vina.pdb de la carpeta Vina y dar 

clic en “Abrir”. 

2.4.10.6 La proteína se proyectará con fondo negro y diversas coloraciones. 

Dar clic en el apartado “Receptor-Ligand Interactions” (flecha azul) que se encuentra 

en las pestañas superiores: 
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2.4.10.7 En el cuadrante izquierdo, localizar la opción “Ligand Interactions” 

(flecha azul). Al dar clic, observar que se centra en las interacciones que tiene el 

ligando con los aminoácidos de la proteína: 

 

2.4.10.8 Dar clic en el apartado “Show 2D Diagram” (flecha azul) encontrado 

debajo de las mismas opciones. Esto hará que se despliegue una nueva ventana 

(flecha roja) mostrando las interacciones que se tienen en 2D: 

 

2.4.10.9 Para guardar la imagen, dar clic en File>Save As… 

Elegir la carpeta Vina para guardar la imagen con el nombre: 

3n8z-FLP-complejo_vina-Ligand 2D 
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Dar clic en “Guardar”. 

Posteriormente, abrirá una ventana preguntando por las dimensiones de la imagen, 

por lo que una vez concluido, dar clic en “OK”: 

 

Teniendo como resultado la siguiente imagen: 

 

2.5 EJERCICIOS 

1. El celecoxib es un inhibidor selectivo de COX-2 (DeWitt, 1999), desarrollado 

en el año 1997. En esta época la técnica de docking era muy nueva y recién se 

empezaban a utilizar métodos distintos alternativos a la farmacología clásica. 

A un estudiante de QFB de la Universidad Autónoma Metropolitana le pidieron 

realizar un estudio con docking molecular para corroborar que el celecoxib es 

específico de la COX-2, empezando por demostrar su posible interacción con la 

COX-1, por lo que es necesario responder: 
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a) ¿Cuál es el sitio activo de la COX-1? 

b) ¿Cuál es el mecanismo de acción de celecoxib? 

c) ¿Cuáles son los valores de Grid utilizados en su práctica para que pueda ser 

reproducible por alguien más? 

d) ¿Qué afinidades se presentaron entre ligando-receptor y cuál sería la mejor? 

e)  ¿A qué aminoácidos se une el ligando y qué interacciones existen entre ellos?  

Puede utilizar la proteína utilizada en el ejemplo (3n8z) para la realización del 

docking en AutoDock Vina. 

 

2. Resuelto lo anterior, realizar un estudio de docking en una enzima COX-2 y 

responder lo siguiente: 

Para este ejercicio puede utilizar la enzima 5KIR. 

a) ¿Cuál es el sitio activo de la COX-2? 

b) ¿Cuáles son los valores de Grid utilizados en su práctica para que pueda ser 

reproducible por alguien más? 

c) ¿Qué afinidades se presentaron entre ligando-receptor y cuál sería la mejor? 

d) ¿A qué aminoácidos se une el ligando y qué interacciones existen entre ellos? 

e) ¿Existen diferencias significativas entre los valores antes dados con respecto 

a las afinidades presentadas en el ejercicio anterior? ¿Cómo las explicaría? 
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